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1. Introduction
1.1 New in RSTAB 8

With RSTAB, Dlubal's structural analysis program for spatial frameworks (German: Rdumliche
STABwerke), you've got a powerful tool to cope with a variety of different tasks in civil engi-
neering. The program represents the basis for Dlubal's analysis software composed of various
design modules: RSTAB determines internal forces, deformations and support reactions of
general framework structures. Then, the results can be used in add-on modules for specific de-
signs and other analyses.

The program version RSTAB 8 offers you several useful features and options emphasizing user-
friendliness and easy program handling when working on structural analysis projects. Once
again, we would like to thank our customers for their valuable ideas and remarks.

Please find the most important innovations in RSTAB 8 listed below:

e Graphical user interface in French, Italian, Polish, Portuguese, Russian, Spanish
e 32-bit and 64-bit program versions

e Usage of template models

e Member eccentricities from cross-section dimensions

¢ Input option for hybrid timber cross-sections

o Filter in cross-section library with favorites

¢ Inserting a member to existing member

o Adjustable stiffnesses for cross-sections and members

e Shifting/copying in user-defined coordinate system

¢ Import of files from Bentley ISM, SEMA, cadwork and Scia Engineer

e Import of 3D objects

e Graphical assignment of member properties

e Color symbols in tables for cross-sections and member types

¢ Input of inclination and precamber in absolute values

e Member loads for pipe content full/partly filled

e Load creation from multilayer structures such as ceiling and floor structures

e Selection with ellipse, annulus or intersection line

e Work planes defined by three points or surface axes

e Grid lines in work plane

¢ Color management for cross-section and member types as well as visibilities

e Automatic creation of load and result combinations according to standard specification
e Output of member coefficients and member slendernesses

o User-defined settings for lighting

e Results evaluation by means of clipping plane

o Views navigator for user-defined and generated visibilities and angles of view
¢ Configuration Manager for display properties, toolbars, printout report headers etc.
¢ Mail merge of graphics

e PDF export of printout report

We hope you will enjoy working with RSTAB 8.
Your team from DLUBAL ENGINEERING SOFTWARE
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1.2 Program Capacities

The following values represent the upper limits in the RSTAB data structure. Please note that
complex structures require powerful hardware.

Model data

99,999 objects of each category (nodes, members, cross-sections etc.)

Load data
99,999 objects of each type of load per load case

Load cases and combinations

Load cases (linear calculation) 9,999
Load combinations (non-linear calculation) 9,999
Result combinations 9,999
Super combinations 9,999

Table 1.1: Program limits of RSTAB

1.3 Company Profile

Since its beginnings in 1987, DLUBAL ENGINEERING SOFTWARE has been involved in the develop-
ment of user-friendly and powerful programs for structural and dynamic analysis. In 1990, the
company moved into its current location to Tiefenbach in Eastern Bavaria. A local branch exists
since 2010 in Leipzig.

When looking at our programs you can feel the enthusiasm of everybody involved in the soft-
ware development and you will notice the underlying philosophy of all our applications, which
can be expressed in one word: user-friendliness. These two points combined with our exper-
tise in engineering are forming the base for the ever-growing success of our products.

The software has been designed in such a way that even users with basic computer skills can
handle the software successfully after a short while. With considerable pride, we now number
more than 7000 engineering offices as well as construction companies from a variety of fields
and places of higher education among our satisfied customers all over the world. To remain
true to our objectives, there are more than 150 internal and external employees working con-
tinuously on the development and improvement of DLUBAL applications. For general questions
and problems our customers can always rely on our qualified fax and email hotline.

The perfect balance between price and performance combined with excellent customer ser-
vice provided by experienced civil engineers make DLUBAL programs an essential tool for any-
one working in the areas of structural engineering, dynamics and design.
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Dipl.-Ing. (FH) Paul Kieloch

1.5  Using the Manual

Many roads lead to Rome - this policy also applies to working with RSTAB: graphics, tables and
navigators are on an equal footing. The descriptions in this manual follow the sequence and
structure of the tables provided for model, load and results data. The individual tables are de-
scribed in detail column by column. Instead of presenting general Windows features, the
manual often focuses on practical hints and tips.

If you are new to the program, you should work with the introductory example first, describing
step by step how to enter data. Please find the PDF document available for download on our
website www.dlubal.com/downloading-manuals.aspx. In this way, you can get quickly familiar
with the most important features of RSTAB. The example can also be performed within the re-
strictions of the demo version.

The text of the manual shows the described buttons in square brackets, for example [Apply].
At the same time, they are shown in the left margin. In addition, expressions used in dialog
boxes, tables and menus are set in jtalics to clarify the explanations.

The index at the end of the manual helps you to find specific terms and subjects. However, if
you don’t find what you are looking for, please check our website www.dlubal.com where you
can go through our FAQ pages by selecting particular criteria.

I Program RSTAB © 2013 Dlubal Engineering Software

Dlubal ———


http://www.dlubal.com/downloading-manuals.aspx
http://www.dlubal.com/

IR
I
Dlubal —

2 Installation

Engineering Software

2. Installation

2.1  System Requirements

In order to use RSTAB without any difficulties, the following system requirements are recom-
mended:

e Operating system Windows XP/Vista/7/8

e x86 CPU with 2 GHz

e 2GBRAM

e DVD-ROM drive for installation (alternatively a network installation is possible)

¢ 10 GB hard disk capacity, including approximately 2 GB required for installation

e Graphic card with OpenGL acceleration and resolution of 1024 x 768 pixels. Onboard so-
lutions and shared-memory-technologies are not recommended.

RSTAB is not supported by Windows 95/98/Me/NT/2000, Linux, Mac OS or server operating
systems.

No product recommendations are made, with the exception of the operating system, as RSTAB
basically runs on all systems that fulfill the system requirements mentioned above. If RSTAB is
used for intensive calculations, the guiding principle 'more is better' applies.

When complex structural systems are calculated, huge amounts of data are produced. As soon
as the main memory is not sufficient for taking the data, the hard drive will take over, which
can slow down the computer significantly. Therefore, upgrading the main memory will usually
speed up the calculation more than a faster processor.

As the RSTAB analysis core supports several processor kernels, you can completely exploit the
potential of 64-bit operating systems. For 32-bit systems the memory size used by the proces-
sor is limited to 2 gigabytes. Therefore, more memory can be used with the 64-bit technology.
If you work with a computer having sufficient RAM memory using a 64-bit operating system, it
is possible to calculate also big models.

To calculate complex structural systems, we recommend to use the following configuration:
e Quad-core processor
e Windows 7 64-bit
¢ 8GBRAM

2.2 Installation Process

The RSTAB program family is delivered on DVD. In addition to the main program RSTAB, the
DVD contains all additional modules that belong to the RSTAB program family, for example
STEEL EC3, TIMBER Pro, RSBUCK etc.

Before you install RSTAB, close all applications running in the background.

Please make sure that you are logged on as administrator or to have administrator rights for
installing the programs. When working with RSTAB later, user rights will be sufficient. Please
find detailed instructions shown in the User Rights video available on our website .

10
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2.2.1 Installation from DVD

On the back side of the DVD case you can find instructions for installation.

e Insert the DVD into your DVD-ROM drive.

e The installation process starts automatically. If it doesn't start, the autorun function may
be inactive. In this case, start the file setup.exe on the DVD either in the Explorer or by
entering the command ,D"\setup.exe in the input field of the Start menu (D refers to the
drive letter of your DVD drive).

e Select the language in the start dialog box.

:

I | anguage

Deutsch

RSTABS —=
= Cesky
RFEM™~ ..
- Zusatzmodule Francais
Add-on Modules

Italiano
DUENQ | SHAPE THIN
DICKQ |SHAPE MASSIVE i
e Portugués
Pycckwia

T T T S S W R W S

©2012 Ingenieur-Software Dlubal GmbH = www.dlubal.de = www.

Figure 2.1: Select language

e Inthe next dialog box, define the program version (64-bit or 32-bit).
e Follow the instructions of the Installation Wizard.

Connect the dongle to a USB port of your computer only after the installation is complete. The
dongle driver will be installed automatically.

The DVD also contains instructions for installation and the RSTAB manual in PDF format. To
look at the manual, you need the Acrobat Reader that you can install from the DVD.

RSTAB as full or trial version

When you start the program for the first time after the installation has been completed success-
fully, you have to decide if you want to use RSTAB as a full version or a trial version for 30 days.

To run the program as a full version, you need a dongle (hardlock) and an authorization file
Author.ini. The dongle is a plug to be plugged in a USB port of your computer. The authoriza-
tion file contains coded information about your license(s). Usually, we send you the Author.ini
file by e-mail. Also the Extranet to which you log in on our website www.dlubal.com provides
access to your authorization file. Save the Author.ini file on your computer, a USB flash drive or
in the network.

Each work station requires the authorization file. The file can be copied as many times as re-
quired. However, if the content will be changed, it cannot be used anymore for authorization.

Itis also possible to run the RSTAB full version with a softlock licence without dongle.

Dlubal ——
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2.2.2 Network Installation

Local licenses

The installation can be started from any drive of your computer or server. First, copy the con-
tents of the DVD to the relevant folder. Then, start the file autostart.exe from the client. The fol-
lowing steps do not differ from the DVD installation.

Network licenses

First, install the program on the work stations as described. Then, the licenses will be approved
by the SRM network dongle. Find detailed information about installing the network dongle in
the instructions available on our website.

2.2.3 Installing Updates and Other Modules

The DVD contains the complete program package including all add-on modules. When pur-
chasing another add-on module, you will not necessarily receive a new DVD but always a new
authorization file Author.ini. To update the authorization without reinstallation, select Load
Authorization File on the Help menu in RSTAB.

Old program files are removed and replaced by new ones while installing the update. Of
course, your project data is preserved!

If you use printout report headers that you have defined yourself, save them before installing
the update. The headers are normally stored in the file DlubalProtocolConfig.cfg that you
find in the general master data folder C:\ProgramData\Dlubal\Stammdat. The file won’t be
overwritten during the update. Nevertheless, saving a backup file may be useful.

We also recommend to save your report templates before you install an update. They are
stored in the file RSTABProtocolConfig.cfg in the folder C:\ProgramData\DIubal\RSTAB 8.01\
General Data.

The projects linked in the Project Manager are managed in the ASCII file PRO.DLP which can
normally be found in the folder C:\ProgramData\Dlubal\ProMan (see Figure 12.21, page 385). If
you want to uninstall RSTAB before installing the update, you should save this file, too.

2.2.4 Parallel Installation of RSTAB Versions

The Dlubal applications RSTAB 6, RSTAB 7 and RSTAB 8 can be run parallel on the computer
since the program files are stored in different directories. The default folders of these program
generations are the following for a 64-bit operating system:

e RSTAB6: C:\Program Files (x86)\Dlubal\RSTAB6
e RSTAB7: C:\Program Files (x86)\Dlubal\RSTAB7
e RSTAB8: C:\Program Files\Dlubal\RSTAB 8.01
All models created with the previous version RSTAB 7 can be opened and edited in RSTAB 8.

Models from RSTAB 7 won't be overwritten when saving them in RSTAB 8 as both programs
use different file endings: RSTAB 7 saves model data in the format *.rs7, RSTAB 8 in *.rs8.

Model files of RSTAB 8 are downward compatible with certain restrictions. When you open an
RSTAB 8 model file in a previous version, a message appears telling you for example that com-
patibility problems for members with unsymmetric cross-sections may occur.
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Graphical User Interface

The following figure shows the most important areas of the program interface.

When you open one of the examples included in RSTAB, your screen should look like shown in
Figure 3.1. The graphical user interface corresponds to usual Windows standards.
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Figure 3.1: RSTAB graphical user interface
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3.2 Terminology
This chapter explains important terms used in this manual relating to the user interface pro-
vided by Windows.

Different terms are used to describe the elements of the user interface. This manual uses Eng-
lish expressions often referring to the Microsoft Manual of Style for Technical Publications. Some
terms are summarized if their differentiation is not essential for the operation of RSTAB.

The following table describes frequently used terms.

Term Figure Synonym | Explanation
Menu . Options | Modules Window Help Pull down Commands and
Display Properties 3 gl:l Edit... menu functions below
%2 | Units and Decimal Places... B3 | Default the title bar
@ Display Margins and Stretch Factors...
?' Customize Tool Icons...
E-a Program Options...
ﬁﬁ"‘ Configuration Manager...
Context . Pop-up Open the context
menu | & EditNodal Support.. menu menu by clicking
I Delete Nodal Support an object with
'@:;. Increase Size the I'ight mouse
=, | Decrease Size button.
Axis Systems on/off Contains useful
EI: Display Properties... commands and
functions for the
selected object.
Toolbar DNE9IEER v A48 Button bar | Collection of but-
Y Y IE e A tons below the
menu bar
Dialog ("Find Object with Number == Window used for
box _ data inputin the
Object No. . .
[Node 7] . main window
ak. ] [ Cancel
Tabs Mode! Data === | Register Large dialog box-
Load Casee. | Load Combinations | Resut Combinations | SC__| Resuts | Prntout Reparts | ) es are subdivided
L& into several tabs.
No Description Resuits
LT e ' Click a tab to
C3 | Lateral wind in +X Yes open the corre-
Lc4 ‘Wind on gablein Y Yes . .
15 |Wind on gablein Y Yes sponding index
IC6 | Windlifing Yes d
Lc7 Imposed load - floor Yes cara.
ICE | Imperfection towards +X Mo
IC3 | Imperfection towards -Y Mo
Lc1o Imperfection towards +Y No
Lcn Exceptional loads Yes
x
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HE
HE
HE
=
2}

i

%ad Cases and Combinations..,

Mew Load Case...

MNew Load Combination...
New Result Combination...
New Action...

Mew Combination Expression...

Mew Super Combination...

List button of toolbar

Engineering Software

Section [ New Guideline (=S | Group, Elementsina
= ~N frame dialog box that
® Il belong together
Otz logically
*) Bias by 2 points
“) Bias by angle and point
(7 Polar /
(ﬁrame{ers \
S =
[ Description:
Use guideline number
Vi
Button [ Creste Video File =) Icon Click a button to
— start an action
Video File
i
[:4ToolshD eformations. avi " (for example to
open a dialog box
Video Codec Type U-seTime or tO change da—
[Microsoft Wideo 1 v] @ Real
) — () Frame ta)‘
Quality: 1002 [%] |m|
The toolbar con-
Ci ols . .
‘ tains list buttons:
3 Click [¥] to open
o ) a list thh similar
—— functions. The
recently selected
button is dis-
played at top.
Input (oolbar [ Text box, Field for entering
field Mo input box | text or numerical
Input field for description Values
OK. ] [ Cancel ]
Spin boX | [ New Comment =) Spin button | Two tiny buttons
next to an input
Text .
Bis B z field
- Numerical values
Options Offset can be changed
[ Framed Usze gradually.
(@) Rectangle %y @ Wark
Circle )
Z
[ Individual: HZ
[ ] Fa) fa
Ax: 00004 [m]
Rotation Ay 0000 | [m]
[ oo | 0.000 ] [
o
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List f New Linear Dimension @1 List bOX, Options for inPUt
combo box | fields

Reference Plane

@ Length © 1t Sometimes user-

= ) 2rd . o

©ax . defined specifi-

® Ay .

= cations can be

Current C5 added.

Options

[ Reference label

[ Uit

Symbal: B

[ Hide walus 0

Offset 0

Localy b

2000 w <alfar
Check (Gelect In Plane =) Check box | Yes/No decision
box " by ticking or
e clearing the
() Remave check box

Definttion of Plane via

@ 3 Modes

() Palygonal boundary

o] (o)
Selection | [ prausibiity Check [=23a]] | Option but- | Only one of the
field ton options can be

Check Type of Check

Model data W ormal selected.

Load data ith warnings

one, only statistic
Yhich Load Cases
urrent load case
fill
(] 8 ] [ Cancel

Table 3.1: Terms of user interface
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3.3  Special Terms in RSTAB

This chapter explains some important terms specific to RSTAB.

Term Explanation

Nodes In the 3D model, a node is defined by its coordinates (X/Y/Z). The ge-
ometry of the model is defined by nodes.

Member The straight connection between two nodes represents a member. By

properties for material and cross-section a certain stiffness is assigned
to the member. A member is a 1D element.

Set of members

Members can be combined in a set of members. Continuous mem-
bers join members continuously like in a continuous beam. A group
of members, consisting of connected members, can join more than
two members on a single node.

Nodal support

The degrees of freedom are limited for the node.

Nodal load

Force or moment applied to a node.

Member load

A member is stressed by a linear or single load. The load distribution
can be either uniform, linearly variable or parabolic.

In addition to forces and moments, temperature actions and pre-
stresses are possible.

Load case
LC

The loads of an action are managed in a load case, for example ‘self-
weight’ or ‘wind'.
The loads should be defined as characteristic loads (which means

without factors). Partial safety factors can be considered in load or re-
sult combinations.

Usually, a load case is calculated according to linear static analysis, but
a calculation according to second-order or large deformation analysis
is also possible.

Load combination
co

A load combination is used to superimpose load cases, that means all
loads of the load cases in question are summarized.

Usually, a load combination is calculated according to second-order or
large deformation analysis, but a calculation according to linear static
analysis is also possible.

Result combination
RC

A result combination sums up the results of the contained load cases.

Itis also possible to determine the extreme internal forces and defor-
mations from different load cases, load or result combinations by an Or
combination.

However, the additive principle of superposition does not apply for
results calculated according to second-order analysis.

Super combination
sC

A super combination superimposes the results of load cases, load
combinations or result combinations from different RSTAB models.
Super combinations can be used to analyze different stages of con-
struction.

The add-on module SUPER-RC is required.

Table 3.2: RSTAB-specific terms

Dlubal ——
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3.4 RSTAB User Interface

This chapter describes the individual control elements of RSTAB (see Figure 3.1, page 13). The
program follows the general standards for Windows applications.

3.4.1 Menubar

Below the title bar you see the menu bar. All functions of RSTAB can be accessed in the menu
bar. The functions are organized in logical blocks.

Open a menu by a single click on the left mouse button. You can also use the keyboard by
holding down the [Alt] key in combination with the underlined letter of the menu title. Then,
the menu opens and you can see its menu items. Select the entries by mouse-click or by press-
ing the underlined letter. You can also select an item by using the cursor keys [*] and [{] and
finally pressing the [] key.

When a menu list is opened, you can switch between the menus or subentries by using the
[—]and [«] keys.

For some menu items a keyboard shortcut is additionally shown. These key combinations fol-
low the Window standards. Use shortcuts to start the functions directly with keyboard keys (for
example [Ctrl] + [S] saves data).

EX 3.4.2 Toolbars

Etl I&ad Cases and Combinations...
Below the menu bar you see the toolbars with various buttons. Use these buttons to access the

most important functions directly by mouse-click. A short information of the button function
appears when you point to a button using the mouse pointer (ToolTip, ScreenTip).

“§ | Mew Load Case...
%% Mew Load Combination...

E} Mew Result Combination...

2% | New Action... Some buttons provide subentries like a menu: These list buttons contain topic-related func-
¥ | New Combination Expression... tions. Click [¥] next to the button symbol to access the functions. The recently selected button
2% New Super Combination... is preset at the top of the list.

To change the position of a toolbar, grab the bar in its front area with the left mouse-button.
Then move it to the desired position.

EAROGDSF ROARE-494- &-

Figure 3.2: Docked position of View toolbar

List button of toolbar

When you drag the toolbar into the workspace, it becomes a ,floating” toolbar.

View %
EERAGS RARD-F- ©-

Figure 3.3: Floating position of View toolbar

To re-dock the floating toolbar, move it to the window frame with the mouse button. You can
also double-click its headline.

On the View menu, click Arrange Toolbars Customized to open a dialog box for changing
the content and look of toolbars (see Figure 3.4). Customizing toolbars follows Windows
standards.

18
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Reset Defaults
Copy Button Image
Delete

Button Appearance...
Icon

Text

Image and Text

Start Group

Context menu of a button

or menu item

Engineering Software

r ~
Customize &J
Commands | Toolbars I Menu Items I Options |
Categories. Commands
Eillgt j?. Coordinate System -
]
View Settings of Work Plane, Grid/Snap, Object Snap, Guide Lines
Insert =
Load Case -¢:— Set Origin of Grid/Work Plane
Calculation m -
Rastite '@' Work Plane XY
I Work Plane Y2
Options i
Add-on Modules B work Plane X2
:’;Tpdow Ak Work Plane with Three Points
All Commands 8 show Grid
K Connect Members
Gef Plausibility Check
' Check for Identical Nodes
Note: ==, Check for Overlapping Members
;O:Cdodm%;?jn;rgraonn?ﬁ;ag ‘_"‘;_ Chedk for Crossing Mot Connected Members
Commands list and drop the ‘D"E‘ Check for Independent Systems -
command on the target
toolbar or menu. Checks the model for overlapping members,

L A

Figure 3.4: Customize dialog box, tab Commands

All commands of RSTAB are sorted by Categories. Select an entry of the list to see the buttons
of all associated Commands to the right. Click a button to get an explanation of the button
function shown in the dialog section below. All buttons can be moved to any place in the
toolbar by using the drag-and-drop function. It is recommended to place such additional
buttons in a new toolbar (see Figure 3.6) because the remaining toolbars may be reset to the
default entries when an update is done.

To remove a button from the toolbar, the Customize dialog box must be open. Then, you can
drag and drop the button from the toolbar to the workspace. It is also possible to use its con-
text menu shown on the left to Delete the button.

In addition to dragging commands into the toolbar, you can shift them into menus. In this
way, you can create user-defined menus. Menu items can be deleted or adjusted by user speci-
fications as described for toolbars.

The option Button Appearance available in the context menu opens the following dialog box:

Button Appearance &J

@ lcon only @ Use default icon:
) Text only Select user-defined icon:
) lcon and text

Description:

Sets new guideline
ia graphics.

Button text: New Guideline Gra| [ oK ][ Cancel

L5 4

Figure 3.5: Dialog box Button Appearance

The dialog box helps you to change the Text of the button or menu item. Moreover, you can
replace the default symbol by a user-defined icon.

I Program RSTAB © 2013 Dlubal Engineering Software
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off toolbars or create new ones by using the [New] button.

r ~
Customize @
[ Commands | Toolbars |penu Ttems | Options
Toolbars Options
[ Show text labels
[C|Export/import
[¥]Insert
[V|Results
[¥]Tocls
(] view
Toolbar |i|
M ame
User-defined
oK ][ Cancel

L

Figure 3.6: Creating a new toolbar

be removed, but switched off only.
creating new toolbars (see above).

lowing Designs can be selected:

Design

[Of‘ﬁce '07 Silver Style
Windows 2000

Office ¥P

Windows XP

Office 2003

Visual Studio,NET 2005
Office '07 Aqua Style
Office '07 Blue Style

Office '07 Black Style
Office '07 Silver Style

Figure 3.7: Available designs for the user interface

The new setting will be active immediately.
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All available toolbars are listed in the Toolbars tab of the Customize dialog box. You can switch

Enter the Name of the new toolbar in the Toolbar dialog box and click [OK]. The new bar will
appear in a floating position on the display. You can shift the toolbar to an appropriate posi-
tion and fill it with buttons by using the Commands tab (see above).

The button [Reset All User-defined Toolbars] resets the initial toolbar state. When the list con-
tains a customized toolbar, the toolbar will be removed. The default toolbars of RSTAB cannot

In the tab Menu Items, you can create user-defined pull-down menus. Proceed as described for

Use the final dialog tab Options to change the appearance of the RSTAB user interface. The fol-

20
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3.4.3 Project Navigator

To the left of the work window you see a navigator that looks like the Windows Explorer. To
display or hide the Project Navigator, open the View menu and select Navigator, or use the
corresponding toolbar button.

NB9IeBeE o FAQRT [EIE #a Lo -serweignt -
e V. 2 X ART %A Mol Z@lﬂflﬁﬁrﬁ?ﬂv%

Figure 3.8: Navigator button in the Default toolbar

The navigator shows the model data of opened files in a tree structure. Click [+] to open a
branch of the tree, click [-] to close it. You can also double-click the entry.

Similar to toolbars, you can use the mouse to "grab" the navigator in its title bar and move it to
the workspace. To dock it again, double-click the title bar or move the navigator to the win-
dow frame. When moving the navigator, directional buttons shown on the left will additionally
appear, facilitating the docking to one of the four sides of the work window. Drag the naviga-
tor to the arrow button of your choice and release the left mouse button as soon as the pointer
is placed on the button.

If you do not want the navigator to be docked to the window frame, clear the corresponding
selection in the context menu of the navigator.

When the menu item Synchronized Selection is ticked, RSTAB shows an object that is selected in
the navigator also highlighted with colors in the model graphic.

The context menu option Auto Hide allows you to minimize a docked navigator: As soon as you
click into the work window, the navigator slides to the edge and becomes a thin bar (see Fig-
ure 3.9). You can also use the pin button on the top right of the navigator to select this func-
tion (see Figure 3.10, page 22).

The navigator opens in full size when you move the pointer across the Project Navigator field
highlighted in the docked navigator bar.

JE| RSTAB 8.01 (326it) - [Steel frame hall = | B ||

FD File Edit View Insert Calculate Results Tools Table Options Modules Window Help Ao
N@99eER o 74QQREE|EE 2 1a-serweignt T Q> PR 6 R S B E R E S
W K DVAEITBRYTTIA-FEH D HAAOTF I RIAER-A- - T W W wm o r

LC1 : Self-weight =
=
3

N e

Navigator automatically in background

Panel automatically in background

eleq - Jojefinep Joalold

- r’ § Tables automatically in background

1.1 Nodes

[SNAP GRID [CARTES [OSNAP [GLINES [OXF

Figure 3.9: Navigator, tables and panel in auto hide mode

Dlubal ——
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At the bottom edge of the navigator you see three tabs (four after calculations). Use the tabs to
switch between Data, Display, Views and Results navigators.

Project Mavigator - Data x Project Mavigator - Display x
ET RSTAR - =[] Model
9@ Introductory Bxample | 10 e E‘& Nodes
558 Model Data [-[¥]5 Nodal Supports
-2 Modes E-[¥]5 Members
w-E Materials |l | e E‘& Member Elastic Foundations
(-3 Cross-Sections []D& Member Axis Systems xy.z
..... ) Member End Releases | []D& Member Axis Systemns u,v,w
-2 Member Eccentricities || I - ] Member Orientations
..... #] Member Divisions --[#]% Member End Releases
@& Members | ||| e 1% Material Descriptions
-\ &) Nodal Supports | || | i e 1% Bottom Fibers
"‘ L16YYN Il e 1% Cross-Section Outlines
..... 3 Member Elastic Foundations D& Cross-5ection Descriptions
..... 1] Member Monlinearities —-[]&% Line Mode at Member Ends

- Sets of Members 1| b E‘& Eccentricities

&% 1:Horizontal beam left: Members: 23 || | | | e [#]& Front Areas Distinguished by Color
b, Jﬁ 2: Horizontal beams right: Members: 45 || | 1 b E‘& Spring Members
= Load Cases and Combinations []E‘& Sets of Members

= Load Cases -[¥]5 Tendons
) LC1: Self-weight w14 Loads
I LCZ: Snow []---EE Results
) LC3: Wind in +X -] 5 Guide Objects
i ) LC: Imperfection towards +X []---Da General
H-op Actions -] Mumbering
]E} Combination Expressions []D& Colors in Rendering According to

I

H-o 8 Load Combinations

[

[

-0 # Action Combinations ‘JD‘) Rendering
[

o # Result Combinations

B Supports

- Loads

- Results (- [E] 5 Preselection

[#-_J Printout Reports - =-[8] % Add-on Modules
'l 1 + i..[w] B Connection Descriptions
aData é"Display ,ZjViews D Results ﬁData é"Display ,ZjViews  Results

Figure 3.10: Tabs for Data and Display in Project Navigator

Data navigator

m This navigator manages model and load data as well as calculated results. Double-click an en-

try (a “leaf” of the tree structure) to open a dialog box for changing the selected object. When
you right-click an entry, a context menu appears with helpful functions used to create or modi-
fy the object.

Incorrectly defined objects are displayed in red, unused objects are displayed in blue letters.

Display navigator
T This navigator controls the graphic display in the work window. When you clear the check box
= of an entry, the corresponding object will be hidden in the graphics.
Save Settings As. Use the context menu of the navigator shown on the left to save or import user-defined set-
Load Settings... tings. You can also apply saved settings as default for new models.

Save Settings as Default

Dlubal 5tandard

Undock
Dock

Auto Hide

Hide
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_ﬁ Views

> Results

Project Mavigator - Views x

e

User-defined views:

i

O &sis B
O Suppart

Lo (]

Visibilties
%

User-defined / generated:

E||:|._| Uszer-defined

| - EE Group 1

[v] B Columrz asis &
] @ Columrs axis B
E||:|._| Generated

[] 23 Members by Cross-Section
1 23 Members by Division

] 23 Members by Material

[] 23 Members by Release

[ 23 Members by Type
] 23 Modes with Support

] W Mo. ondary be A,
[ O Na. 2- Secondary beam B-B
[ @ Mo 4 - Column &4

@ 4=23E EEEE

[ &dd mew objects inta visibility:

ﬁData @Display Aviews O Results

Project Mavigator - Results
=[] Global Deformations
@ u

-OFD ux

O uy

-OF uz

SO ox

-OF oy

[—]E‘,L Members
[#-[B], %4 Local Deformations
BD,L Internal Forces

..... e Vz
..... e M7

..... = M
=-[¥] 4% Support Reactions
£)-[¥] 4% Nodal Supports

O 4" Components

ﬁData @Display Aviews > Results

Figure 3.11: Tabs for Views and Results in Project Navigator

Views navigator

This navigator manages user-defined views as well as user-defined and automatically created
visibilities of objects (used to be "partial views" and "groups" in RSTAB 7). Buttons are available
to create user-defined views, to set visibilities, to integrate objects into user-defined visibilities

etc.

Working with views and visibilities is described in chapter 9.7.1 on page 212.

Results navigator

With the last navigator you control the results displayed in the graphic. Available entries de-

pend on whether results of RSTAB or an add-on module are displayed.
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3.4.4 Tables

|D| At the bottom edge of the RSTAB window you see tables. On the Table menu, click Display to
switch the tables on and off, or use the corresponding button.

E File Edit Wiew Insert Calculate Results Tools Table Options Modules Window Help
N@9PeE@dER e FIQ@FDET |i¢ LC1 - Seff-weight T4 >
BB VAR Y ERYTPI AP o RAZR-H

Figure 3.12: Button Table on/off in the Default toolbar

There are four groups of tables. To switch between them, use the first four buttons displayed
in the toolbar of the table, or point to Go To on the Table menu.

| B 1 1.1 Nodes Tables for model data
— IAEEE &80
Table 1. I‘.-Iacll Data | Reference Coordinate
No. Node Type MNode System ¥ [m]
Table menu — Go To — Model Data
|| 21 Load Cases Tables for load cases and
e = | o3[ € O | @] [= 5] 5| * combinations
1 T
Load [Table 2, Load Cases and Combinations }B—I:
Case Description To Salve
Table menu — Go To — Load Cases and Combinations
| ! | 3.1 Nodal Loads Tables for loads
= BAEES == P @ = E| K *
- B | € ] ©
Table 3. Loads Force [N
No. On Nodes No. Px Py Pz
Table menu — Go To — Loads
|E| 4.1 Members -Bernal Forces Tables for results
pEEEIR G
A—T—a——] C [ D
I'u'hernlcner\m,liqisunﬂL Forces [lkN]
Na. No. x [m] N Wy
Table menu — Go To — Results
Table 3.3: Buttons for control of table groups
The tables manage all model and load data numerically. Several powerful functions allow for
an efficient data input (see chapter 11.5 on page 321).
By working through the tables successively RSTAB ensures that all data is captured. The tables
represent the internal organization of RSTAB data. Descriptions of input and output to be
found in chapters 4, 5, 6 and 8 are based on the structure of these tables.
Similar to toolbars, you can use the mouse to "grab" tables in their title bar and move them in-
= to the workspace. To dock a table, double-click its title bar, or move the table to the window
) g frame or one of the directional buttons shown on the left.

Docked tables can be minimized when the context menu option Auto Hide is set. As soon as
you click into the work window, they slide to the edge (see Figure 3.9, page 21). You can also
use the pin button on the top right of the table to select the minimize function. The tables
open in full size again when you move the pointer over the docked bar.
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When selecting a table row by mouse click, related objects are highlighted with colors in the
graphic. Reciprocally, when an object is selected in the work window, the corresponding table
row is displayed and highlighted, too. To control the settings for the "synchronization of selec-
tion", point to Settings on the Table menu. You can also use the table toolbar buttons shown
on the left (see chapter 11.5.4, page 327).

3.4.5 StatusBar

At the bottom of the RSTAB work window you see the status bar.
On the View menu, click Status Bar

to switch the bar on and off.

The status bar consists of three areas.
Left area

Member load Mo. 3 on member Mo. 13

Figure 3.13: Left area of status bar

The displayed text varies depending on the program function that is active. When the pointer
moves across the work window, information appears about the object indicated by the point-
er.

If you are an RSTAB beginner, keep an eye on this section of the status bar: You may find useful
hints and descriptions for toolbar buttons and dialog boxes.

Center area

[SNAF GRID [CARTES [OSNAP |GLINES [DXF

Figure 3.14: Center area of status bar

Its functionality is similar to the one of a toolbar, controlling the display of the work window.

SNAP

The button enables or disables the snap function of the grid. Use the context menu to access
the dialog box with specific settings for grid parameters (see chapter 11.3.2, page 278).

Dlubal ——
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2

2

Show Grid

Multiply 2x Space
Divide 2x Space

[CARTES [0SNAP [GLINES [DXF

=2

~2

Polar Grid On

Multiply 2x Space
Divide 2x Space

Woark Plane and Grid/Snap

Work Plane

Coordinate system:

Origin of Work Plane

Mode Mo

=
> |1

Standard - . o
E Coordinates  # 0.00015 |+ [m]
Just v 60002 [l
GNP AT T+x
vz * I' Z 00005 [m]
z
Grid/Snap | Object Snap | Guidelines | Background Layers I Line Grids
Show Type Number of Grid Points
Grid @) Cartesian [ Dynamically according ta size of madel
[¥] Shap 1 Polar @ U
¥ 5
Distance: 108 [p«] - - =
Direction 1: 30 305
: : 2. WS 30
- ;
T
- -/ Grid Point Spacing
: ) : | ) | Space b: 100015 x| [m]
y -b.b.b.b.
N ] he 1.0001 %] [m]
c []
4:'— ;_"-.‘_‘j[} | Fiotation B: 0005 | [
fy .," 1 ML -
£ | | Grid Line Spacing
A =
2 - Mumber ni: 105
nz: 105

|

GRID

gradually.

spacings gradually.
OSNAP

GLINES

DXF

Right area

C5: Standard

ORTHO / CARTES / POLAR

Use this button to select the orthogonal, Cartesian or polar grid. With the context menu you
can open the dialog box shown in Figure 3.15. In addition, you can enlarge and reduce grid

Flane: YZ

Figure 3.15: Dialog box Work Plane and Grid/Snap

X: 6.250m

The button controls the display of guidelines (see chapter 11.3.7, page 290).

Y. -20000m Z -6546m
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Click the button to switch the grid on and off. Select Edit in the context menu to open the dia-
log box shown in Figure 3.15.

In addition, the context menu offers the possibility to maximize or minimize grid spacings

The button activates or deactivates the object snap (see chapter 11.3.3, page 279).

This button switches the display of background layers on and off (see chapter 11.3.10, page 297).

Figure 3.16: Right area of status bar

The right area of the status bar shows the following information about graphically entered data:
o Visibility mode (if active)
e Coordinate system CS
e Work plane
e Coordinates of current pointer position
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3.4.6 Control Panel

As soon as internal forces or deformations are displayed graphically, the panel appears in the
work window, offering different possibilities for display and control. To switch the panel on
and off,

select Control Panel (Color Scale, Factors, Filter) on the View menu
or use the button shown on the left.

Similar to a toolbar, you can use the mouse to "grab" the panel in its title bar and shift it into
the workspace. To dock the panel, double-click its title bar, or move it to the window frame or
one of the directional buttons shown on the left.

The docked panel can be minimized when the context menu option Auto Hide is set. As soon
as you click into the work window, it slides to the edge (see Figure 3.9, page 21). You can also
use the pin button on the top right of the panel to select the minimize function. The panel
opens in full size again when you move the pointer over the docked bar.

The control panel consists of the following tabs: Color scale, Factors and Filter.

Color scale

Panel x

Intemal Forces
M [kN]
112.30
94.72
77.15
59.57
4199
2442
6.34
-10.73
-28.31 Options
-45.89 ? @
£346 Refer ta
-81.04

I axdmin

@ Customize... @

Max © 11230 Limits:

Min : -81.04

Smoath color transition

BEla 4

Figure 3.17: Control panel, tab Color scale with active Options dialog box

When a multi-color results display is set, the first tab shows the color spectrum with assigned
ranges of values. Eleven color zones are set by default, covering the range between extreme
values in equally spaced intervals.

To adjust the color spectrum, double click one of the colors. You can also use the [Options]
button available in the panel. The Options dialog box opens (Figure 3.17) where you can click
the [Edit] button to access another dialog box for changing the ranges of colors and values.

Dlubal ——
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Edit Isoband Value and Color Spectra &J
. Value Spectrum
27| —
Default Default
B4 —_—
Empty
4839615 —_—
Fill
338015
Fill b4 2 /Min
18655 —
Save...
3495
A1E6 .
26825
Color Spectrum
4197 —_—
41.97 5 Default Defat
ki Save...
F2285
- [ Apply ta all result
helihadsalis 1 diagrams
[T E-Format
Double-click on the color panel
to change colors. -
"
[ (0] 3 ] I Cancel

L S

Figure 3.18: Dialog box Edit Isoband Value and Color Spectra

Use the vertical sliders to the right of the values to reduce the number of color ranges at both
ends of the color spectrum.

You can change colors individually by double-clicking a color field.

Furthermore, you can adjust spectrum values manually. Please take care to follow a strictly as-
cending or descending order. Use the buttons in the dialog section Value Spectrum to assign
values. The buttons are defined as follows:

Dlubal —

Button Function

Standard The eleven color zones will be set to default.

Empty All values in the input fields will be deleted.

Fill The values will be equidistantly intercalated between maximum and
minimum depending on the number of color zones.

. . For a reduced color spectrum, the interpolated values are calculated in

Fill Max/Min .
relation to the absolute or manually entered extreme values.

Save The value spectrum will be saved as a global sample.

Table 3.4: Buttons in the dialog section Value Spectrum

Tick the check box in front of Apply to all result diagrams to use the current color spectrum for
the results display of all load cases, load and result combinations. The value spectrum remains
unaffected because a global assignment for deformations, forces, moments and stresses
would be difficult. Click [Save] to save the modified color spectrum as user-defined.

Use the [Options] button as shown in Figure 3.17 to select further options in the Options dialog
box.
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Panel x

Intemal Forces
My [kMNm]
179.49
30.00
2333
16.67
10.00
333
-333
-10.00
1667 Options
2333 ? @
-30.00 Refer to

17951 I axdmin
Customize... =
Max © 17349 I_I

: @ Limits:
Min : -179.51 <
[+]: 30,005

[-1: -30.00%

Smoath color transition

BEla 4

Figure 3.19: Dialog box Options, option Limits +/-

The reference to limit values allows you to evaluate results accurately within a defined zone.
Exceedings of the upper and lower limits are represented by different colors. With the values
set in Figure 3.19 you can see the moments M, displayed in a fine gradation within the range
of + 30 kNm/m. Values beyond the defined zone appear in red or blue color.

Tick the check box for Smooth color transition in the Options dialog box to make the distinct
color zones disappear. The smoothed color spectrum can be set independently, no matter
which one of the three reference options is selected for the result values.

Factors

Panel x
Dizplay Factors

Deformation:

Member diagrams:
2 =

Reaction forces:

1 =

Y
)

B2 4

Figure 3.20: Control panel, tab Factors

Use the second panel tab to control the scaling factors for the graphic display. Depending on
the currently set results graphic, you can access input fields for scaling Deformations, Member
diagrams (internal forces) and Reaction forces.

Dlubal ——
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Filter

Panel x

Show diagrams for
members Mo.:

All
Mone

=)
=
)
X

B a4

Figure 3.21: Control panel, tab Filter

With the Color scale tab you can filter result values in general. Use the Filter tab to control the
results display with regard to particular members.

You have to enter the numbers of the relevant members into the input field Show diagrams for.
Then, with a click on the [Apply] button, you set the filter in the graphic.

Itis also possible to take object numbers from the graphic: First, select the members (multiple
selection via window or by holding down the [Ctrl] key). Then, click the button [Import from
Selection].

The filter settings of the panel also affect the objects in the results tables: For example, when
you restrict the results display in the panel to two members, table 4.1 Members - Internal Forces
will also list only the results of those two members.
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3.4.7 Default Buttons

Buttons are used in many dialog boxes. When you place the pointer on a button, its function
will be displayed as short description after a moment.

The following overview describes frequently used default buttons.

Dlubal ——

Button Description Function
New Opens a dialog box to define an object
Edit Opens a dialog box to modify an object
@ Delete Deletes an object or entry
:1 Select Graphical selection
Qtj Apply Import from the current selection
Library Opens a collection of stored data
Help Opens the help function
E{' Use Applies changes without closing the dialog box
i=‘1 Settings Opens a dialog box for detailed settings
Commes | Ao gt e
Unit's and Settings for units and decimal places
Decimal Places = chapter 11.1.3, page 261
Standard Restores default dialog settings
Set as Default Saves the current settings as default
-"i Font Option to set fonts and font sizes
Colors Option to set colors
Info Displays information about an object

Transfer Selection Transfers selected items from one list to another

Transfer All Transfers all items from one list to another
Save Stores user-defined entries

Import Imports stored entries

Select Selects certain or all objects

Deselect Deletes or cancels all entries

& & B & F e

Table 3.5: Default buttons
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Often required functions in tables and graphical user interface can be accessed with the key-

board.
[F1] Help
[F2] Next table
[F3] Previous table
[F4] Plausibility check for current table
[F5] Plausibility check for all tables
[F7] Selection function in tables
[F8] Copies the table cell above, or shows whole model on screen
[FI] Calculator
[F10] Menu bar
[F12] Saves the model under a new name
[Alt] Menu bar
[Ctrl]+[2] Copies a row of the table to the next row
[Ctrl]+[A] Redo function
[Ctrl]+[C] Copies to the clipboard
[Ctrl]+[E] Exports data
[Ctrl]+[F] Searches within the table
[Ctrl]+[G] Generates entries in the table
[Ctrll+[H] Finds entries in the table and replaces them
[CtrI]+[1] Inserts a row in the table, or imports data
[Ctril+[L] Jumps to a specific row number in the table
[Ctrl]+[N] Creates a new model
[Ctrl]+[O] Opens an existing model
[Ctrl]+[P] Prints the graphic
[Ctrl]+[R] Deletes a row in the table
[Ctrl]+[S] Saves data
[Ctrl]+[V] Clears selection in the table
[CtrI]+[V] Inserts from the clipboard
[Ctrl]+[X] Cuts items in the table
[Ctrl]+[Y] Deletes the content of a row in the table
[Ctrl]+[Z] Undo function
[+]1[-] NumPad |Zoom

Table 3.6: Keyboard functions

Provided that no dialog box is open, the [Enter] key calls up the last used function. Thus, reap-
plication of data is easier, for example placing model or load objects again in the work window.
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3.4.9 Mouse Functions

The mouse functions follow general standards for Windows applications. To select an object
for editing, simply click it with the left mouse button. Double-click the object when you want
to open its dialog box for editing. You can apply these functions to objects of the work win-
dow as well as to entries in the Data navigator.

Model and load objects can be shifted in the work window by drag-and-drop. To copy objects,
hold down the [Ctrl] key additionally. The drag-and-drop function can be switched on and off
in the general context menu (see Figure 11.52, page 287).

When you click an object with the right mouse button, its context menu appears, providing
object-related commands and functions.

Context menus are available in the graphic, the tables and the navigator.

Edit Modal Support...

Delete Nodal Support

Increase Size

Decrease Size

JF

Axis Systems on/off

E\:I Display Properties...

Figure 3.22: Context menu of nodal support in the graphic

By scrolling the wheel button you can maximize or minimize the current model representa-
tion. The pointer position is always assumed as center of the zoom area.

Press the wheel button to move the model directly within the workspace, which means with-
out previously activating the toolbar button [Move, Zoom]. When you press the [Ctrl] key addi-
tionally, you can rotate the model. Rotating the model is also possible by using the wheel but-
ton and holding down the right button of the mouse. The pointer symbols shown on the left
are indicating the selected function.

To rotate the view about a particular node, select the node first. Now, hold down the [Alt] key
and press the wheel button additionally to rotate the model about the selected node.

The options offered by a 3D mouse can also be used for working with the graphical user inter-
face of RSTAB.

Furthermore, RSTAB offers a useful function to display selected objects quickly in maximized
view: First, select the objects in the work window. Now, hold down the shift key [{] and click
one of the buttons available in the View toolbar shown on the left. The work window will show
you a maximized partial view of the object in the selected viewing direction.

Dlubal ——
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3.4.10 Configuration Manager

Iﬂ;f"l The Configuration Manager provides access to all settings available for display properties,
' fonts, toolbars, print headers etc. To open the Configuration Manager, select Configuration
Manager on the Options menu, or use the toolbar button shown on the left.

Configuration Manager - White background &J
Auvailable Configurations Settings
Standard with black background . . |
Skl i b 1. Digplay properties . ............... ..., RE'
White background (current] 2 Programoptions .. ...
Blue background —
3. Toolbars and pulldown menus ... ... &
4. Digplay marginz and stretch factors ... ... ... .. E
S Tablecolors. ... oo &
= B Tablefontz. ............................. |4 {;‘,,
V 7. Printout report header and footer. ... ... ... .. E
v [B) &) (@3] @ (X
Comment

L S

Figure 3.23: Dialog box Configuration Manager

Available configurations

This dialog section lists all configurations that have been user-defined or created during instal-
lation. The setting currently used by the program is shown in bold and indicated as current.

The Standard configuration is preset, it cannot be deleted.

The buttons below the dialog section are reserved for the following functions:

Button Function

Sets the entry selected above as new current configuration

Creates a new configuration from current settings (see Figure 3.24)

Renames the selected configuration

Exports the selected configuration in a file

Imports a configuration from a file

Resets the default values

EIEIPHETEENS

Deletes the selected configuration (not possible for Standard and current)

Table 3.7: Buttons for Available Configurations
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Use the [New] button to save the current settings as a new configuration. A dialog box opens
where you have to enter a Description. An optional Comment makes it easier to select among
various user-defined configurations later.

New Configuration

(S

Description

Blue background

Comment

Option
Set as curent

2

Background with gradient

[ (0] 3 ] I Cancel

L

Settings

Figure 3.24: Dialog box New Configuration

The buttons available in the dialog section Settings provide access to different dialog boxes
with configuration parameters. They are described in the following table.

Button

Description

Function

s

Display properties

Opens the dialog box Display Properties
— chapter 11.1.2, page 258

(1%

Program options

Opens the multi-tab dialog box Program Options
— chapter 7.2.3, page 183

— chapter 9.8, page 222

— chapter 11.1.1, page 257

— chapter 11.1.4, page 263

Toolbars Opens the dialog box Customize
and menus — chapter 3.4.2, page 19
Margins and Opens the dialog box Display Margins and Stretch Factors

stretch factors

— chapter 11.3.11, page 300

> | & | @/ | &

Table colors Opens the dialog box Colors for the table colors
— chapter 11.5.4, page 327
Table fonts Opens the dialog box Font for the table fonts

— chapter 11.5.4, page 327

B

Header and footer
of printout report

Opens the dialog box Printout Report Header
— chapter 10.1.4, page 233

Table 3.8: Function of buttons in the dialog section Settings
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4. Model Data

3 Starting RSTAB
5E To start the program, use the Windows Start menu or the Dlubal icon on the desktop.
D'“bagistf:lB 801 To enter data, a model must be created or opened (see chapter 12.2, page 386).
vl

RSTAB offers different options to enter data: You can define objects in a dialog box, a table
and often directly in the graphic. All input is interactive, which means that graphical input is
immediately reflected in the table and vice versa.

@ For first steps with RSTAB we recommend to try the introductory example that may be helpful
for beginners. You find the corresponding manual available for download on our website
www.dlubal.com/downloading-manuals.aspx

Open the input dialog box

You can access the input dialog boxes and the graphical input in various ways.

Menu Insert

. Insert |
Model Data 4 11 Modes 4
Loads 4 1.2 Materials 4
Load Cases and Combinations ¥ 1.3 Cross-sections 4
Dimensions b 1.4 Member End Releases 4
{3 canment 1.5 Member Eccentricities »
Guidelines N 1.6 Member Divisions 3
line Grid 1.7 Members 4
fz' Clipping Plane 1.5 Modal Supports 3 _Il Graphically...
@ Visual Object 1.9 Member Elastic Foundations  » E Dialog Box.,
£F | Background Layer... 1.10 Member Mon-linearities 4 f Table
111 Sets of Members 4
Figure 4.1: Menu Insert — Model Data
Toolbar Insert
Insert X

YA C Y SIS

Figure 4.2: Toolbar Insert
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Context menu in Data navigator

Project Navigator - Data x

ED RSTAB
- Steel frame hall

== Model Data

& Edit Material... Enter
D"'L_i' EI;OSS:EC & New Material... L\\)
- =] Member
_____ @ Member 8  GotoTable
G-l Member | 3¢ | pelete all Materials Del
G- i) Members | Delete All Unassigned Materials
- &) Nodal Su
----- |38 Member General Data...
""" 9 Member E Units and Decimal Places...
-8 Sets of M
@) Load Cases a EEI Display Properties...
(-] Loads
- Results
[#-+_J Printout Reports
- Guide Objects
-] Add-on Modules
) Stand-Alene Modules
IQData| & Display #Views © Results

Figure 4.3: Context menu of model data objects in the Data navigator

Context menu or double-click in table

1.1 Nodes x

AEES SO E[EEH K FHE S8 F L5

B C [ D E -
Node | Refersnce Coordinate Node Coordinates |
Mo Mode System ¥ [m] Zm] Comment
1 1] Cartesian 0.000 0.000
~ | Cartesian
] 12 2400 -5.240 L
4 v 10.000 -6.000 T
50 - 17,600 -5.240
g &e | Insert Row ctri=1 g% g%
8 | 3= | Delete Row Ctrl=R b
9 -
Mew via Dialog Box...
MNodes | - —r{"e=—nd Rel lMember Eccentricties lMember Divigions lMembem J 4[] [m

Mumber of reference node

Figure 4.4: Context menu in model data tables

The input dialog box can be accessed by means of the context menu (or by double-click) of the
row number.
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Open the edit dialog box
RSTAB provides different possibilities to open a dialog box for editing model objects.

Menu Edit

Edit

¥ | Undo Ctrl+Z

e

B3| copy Ctrl+C
Select 3

ﬁ Find via Number...

By  Delete All

Move/Copy...
Rotate...
Mirrar...

Project...

Seale..,

o
ﬁ Shear...

f Allow Double Members
i

Units and Decimal Places...

Model Data » General Data...
Loads 4

1.1 MNodes »
Load Cases and Combinations 3 i

1.2 Materials 4
Dimensions 4 1.3 Cross-sections 4 ﬁ Dialog Box...
Comments 4 1.4 Member End Releases » ﬁ Table
Guidelines 4 1.5 Member Eccentricities . .

ﬂ Assign Graphically to Members...

Line Grids r 1.6 Member Divisions 4
Background Layers 4 1.7 Members 4

1.5 Modal Supports L3

ﬂE Edit Parameters...

1.9 Member Elastic Foundations  #
1.10 Member Non-linearities »

1.11 Sets of Members 3

Figure 4.5: Menu Edit — Model Data

Context menu or double-click in graphic

9

Edit Node...
K| Delete Node L\:

O% Move/Copy...
-;"_‘n Rotate...
d'h Mirror..,

Mode Marks in Foreground
RI:I Display Properties...
'3 Visibility by Selected Objects
a Visibility by Hiding Selected Objects

Figure 4.6: Context menu of a node in the work window
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Context menu or double-click in Data navigator

Project Mavigator - Data x

E RSTAB -

9@ Introductory Example
=28 Model Data

E| |#) Cross-Sections
.. T 1:HEA300 | DIN 1025-3:1994; Steel 5 235
SN 2 IPE 360 | DIN 1025-5:1994; Steel S 235
-F 2IBUIPE360-3 12 Edit.. Enter
-F 4 1BUIPE 360-1 9 Mew Cross-Section... D\?

----- |&] Member End Reled

@ Member Eccentric x}, Assign Graphically to Members...

----- &1 Member Divisions ﬁ Coltallable

- ) Members M Delete Del
| & Nodal Supports

----- | Member Elastic Fo| [] | select

----- ) Member Menlinea
- |£0) Sets of Members )Y

ﬂData gDisplay _ﬁ\-’iews © Results

Info on Input Errors...

Figure 4.7: Context menu of model data objects in the Data navigator

Context menu or double-click in table

1.1 Nodes *
FE TR EE|FE|O [ [=EH K= FE € S =LA
B C | D | E F -
Node | Refersnce Coondinate MNode Coondinates |§
No. MNode System X [m] Y [m] Z[m] Comment
1 0 Cartesian 0.000 0.000 0.000 | Supported
1] ~ | Cartesian 25.000 0.000 0.000 | Supported
3 | 32| CopyRow — 0.000 0.000 £.000
4 3.000 0.000 -6.261
5 | ¥ Empty Row cr= 6.250 0.000 -6.546
6 |5 12.500 0.000 -7.094
g [E 1=t Row ] 18.750 0.000 £.546
8 | 3= Delete Row Ctrl=R 27000 0.000 5.261
El 25.000 0.000 -6.000 -
B Edit via Dialog Box...
MNodes | [“e—nd Rel | Member Eccentricities | Member Divisions | Members | 144 v[m
Mumber of reference node

Figure 4.8: Context menu in model data tables

The edit dialog box can be accessed by means of the context menu (or by double-click) of the
row number.
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Table input

Input and modifications carried out in the graphical user interface are immediately shown in
the tables, and vice versa. To open the model data tables, use the leftmost button in the table
toolbar shown on the left.

1.1 Nodes b4
|EE= ERENEO @ [=E ] H ke F[E D S F A%
L B [ ¢ [ b E I

No- Loordinate Node Coordinates
Mo. Node System X [m] Z[m] Comment

0 Cartesian 0.000 0.000

I 0 -] Cartesian 0.000 5,000 | Supported
3 0 Cartesian 2.400 -5.240 -
4 0 Cartesian 10.000 -6.000 i
a 1} Cartesian 17600 -5.240
[ 1] Cartesian 20.000 0.000
7 0 Cartesian 20.000 -5.000
8 | 4
] -

MNodes ll‘u‘laterials lCross-Sedicns ll‘u‘lember End Releases lMember Eccentricities lMember Divisions ll‘ll'lembers J | | 4 |>|

Mumber of reference node

Figure 4.9: Button [Table 1. Model Data]

Input in the form of spreadsheet data entered in tables can be quickly edited and imported
(see chapter 11.5, page 321).

Unused objects are highlighted in blue in the tables and the Data navigator.

In each dialog box and table, it is possible to add a Comment specifying the object. You can al-
so use predefined comments (see chapter 11.1.4, page 262). Moreover, comments are part of
ScreenTips for graphical objects.

e K

= | Modal Support Mo, 1:13,14: YYY NMNMN
Support failure under tension

Figure 4.10: ScreenTip of a nodal support
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[
“ | New Mode

j-" Node Between Twao Points

4.1 Nodes

General description

New Node
Node Coordinates | Suppart

Node No.
74

Coordinates Coordinate System 'Cartesian’
Reference

node No.: 0 -

Coordinate

Coordinate X 0.000 ||| [m] c
Coordinate Y: 0.000[2]3] m] 'z

Coordinate Z: [m] ; P (X.Y.Z)
z
Comment
-
oK | [ Cancel

L5 S

Figure 4.11: Dialog box New Node

IR
I
Dlubal

Engineering Software

The geometry of the model is defined by nodes. They are essential for creating members. Eve-
ry node is specified by its coordinates (X,Y,Z). The coordinates usually refer to the origin of the
global coordinate system, but it is also possible to define them in relation to another node.

1.1 Nodes x
EEREFINCO EEEIFE K= FAE I S E A%
T b T ¢ ; B
Node | Reference Coordinate Node Coordinates 7
No. Node System X [m] Y [m] Z[m] Comment B
0 Cartesian 0.000 0.000 0.000 | Supported
2 ] 0 Cartesian - 25.000 0.000 0.000 | Supported
3 0 Cartesian 0.000 0.000 £.000
4 0 Cartesian 3.000 0.000 £.261
5 0 Cartesian 6.250 0.000 £.546
6 0 Cartesian 12.500 0.000 -7.094
7 0 Cartesian 18.750 0.000 £.546
8 0 Cartesian 22.000 0.000 £6.261 -
Nodes | Materials | Cross-Sections | Member End Releases | Member Eccentricities | Member Divisions | Members | [«[»[r
Coordinate systern ('C'artesian / 'X' /"Y' / "Z'-Cylindrical / 'P'olar / F7 to select)

Figure 4.12: Table 1.1 Nodes

chapter 11.4.16, page 318).

nodes already existing (see chapter 11.4.12, page 315).

The node number is assigned automatically in the dialog box New Node but can be modified in
the input field. The order of the node numbering is not important and gaps are permitted.

To adjust the order of node numbers subsequently, select Renumber on the Tools menu (see

Furthermore, RSTAB provides a special function to create a node on the connection line of two

I Program RSTAB © 2013 Dlubal Engineering Software

41



IR
4 Model Data .

Engineering Software

Reference node

In general, coordinates of a node refer to the origin of the global coordinate system. You do
not need to define the node (0/0/0) because RSTAB recognizes the origin automatically.

Any node can be defined as reference node. Even a node with a higher number is allowed to
be used as reference node. Referring to another node may be useful to define for example a
new node in a certain distance to an already known position. The table list with its option "Pre-
vious node" is especially useful in this case.

In the dialog box New Node, you can enter the reference node directly, select it from the list or
define it graphically by using the [\] button.

Coordinate system

The coordinates of a node always refer to a coordinate system that describes the position of
the node in the workspace. Depending on the model geometry you can select between differ-
ent coordinate systems. All coordinate systems are clockwise-oriented.

Cartesian

The global axes X, Y and Z describe a translational expansion (linear). All directions of coordi-
nates are on an equal footing.

* P (XYZ)

Z

Figure 4.13: Cartesian coordinate system

In most cases, nodes can be defined in the Cartesian coordinate system.
X-cylindrical

The X-axis describes a translational expansion. The radius R defines the distance of the node to
the X-axis. The angle © defines the rotation of the coordinates about the X-axis.

The X-cylindrical coordinate system will be applied to represent for example tubular models
whose central axis is the X-axis.

T R R

z

Figure 4.14: X-cylindrical coordinate system

Y-cylindrical
This coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is
represented by the Y-axis.

P (RY.0)

Z

Figure 4.15: Y-cylindrical coordinate system
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Z-cylindrical

The coordinate system is similar to the X-cylindrical system, but now the longitudinal axis is
represented by the Z-axis.

& P (R.H,Z)

Z

Figure 4.16: Z-cylindrical coordinate system

Polar

In the polar coordinate system, the node position is described by a radius defining the distance
to the point of origin and the angles © and ©.

* P (R,0.4)

z

Figure 4.17: Polar coordinate system

If possible, organize the model input with regard to the global coordinate system in such a
way that the X-,Y-, and Z-axes of the coordinate system are in line with the principal directions
of the modeled framework. This allows for an easier definition of coordinates, conditions and
loads.

To define nodes directly in the workspace, open the floating dialog box New Node for graphical
input by clicking the toolbar button shown on the left. Usually, nodes snap on grid points
which are aligned with the active user-defined or global coordinate system (CS).

MNew Mode &J
Node No.
74

Coordinates
Reference —
node: 1] - ‘:‘ ;4
Coordinate —_—
system: Cartesian -
Coordinate IR | [mm]
Coordinate v 3000 [m]
Coordinate Z: 2000 [m]
Reference

Current CS
@ Grid origin
?

e 4

Figure 4.18: Floating dialog box New Node

For more information about user-defined coordinate systems, see chapter 11.3.4 page 283.

When the coordinate system is changed in the table, it is possible to convert node coordinates
automatically to the new system. The following query will be displayed.

Dlubal ——
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== RSTAB
L ! Question No. 56

The coordinate system has been changed!

Shauld the coardinates arginally defined be
transformed inta the new coordinate system?

Mo LCancel

Figure 4.19: RSTAB query

In the same way, you can convert node coordinates with the Previous reference node in rela-
tion to the origin.

Node coordinates

Node coordinates are defined in the coordinate system that you have previously set. When
you model a 3D structure, the node is clearly defined by the coordinates X, Y and Z or the radi-
us and angles. Coordinate parameters and table column titles are changing depending on the
coordinate system.

When the model type has been restricted to a planar 2D system or a continuous beam in the
General Data dialog box, you cannot access all three input fields or table columns.

To adjust Lengths and Angles, select Units and Decimal Places on the Edit menu, or use the
corresponding button in the dialog box.

With the following procedure you can check if all nodes are placed in one plane: Select the rel-
evant nodes and double click one of them to open the dialog box Edit Node. Only those input
fields are filled with coordinates data whose values are conform for all selected nodes. If this is
not the case, you can assign a uniform plane coordinate to the selected nodes now.

Itis possible to import node coordinates from Excel spreadsheets (see chapter 11.5.6, page
329). Furthermore, you can determine node coordinates with the Formula Editor of RSTAB (see
chapter 11.6, page 332). In addition, you can take advantage of several model generators facili-
tating the input (see chapter 11.7.2, page 341).
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To enter accurate, unrounded coordinates, select Full Precision in the dialog box New Node.

fx
\f‘ Measure
&

ok ] [ Cancel

New Node PS

Node Coordinates | Support
Node No.

74
Coordinates Coordinate System 'Cartesian’

Reference

node No.: 0

Full Precision

Coordinate @

system: Value with Full Precision
Walue: 3.25000000008 [m]

Coordinate X: 0.000

oordinate [m] D E-farmat

Coordinate Y: 32505 2 | calculator

Coordinate Z: 0.000 5 Edit Formulas Frecision: [Double

4 Full Precision [

Comment

- =]
[ ok ][ caneel

N

Figure 4.20: Context menu in the dialog box New Node and dialog box Full Precision

Comment

You can enter user-defined notes. Use the button [Apply Comment] to import saved com-
ments (see chapter 11.1.4, page 262).
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4.2 Materials

General description

Materials are required to define cross-sections. The material properties affect the stiffnesses of
members.

A Color is assigned to each material. Colors are used by default in the rendered model for the
representation of objects (see chapter 11.1.9, page 268).

For new models RSTAB presets the two materials that were last used.

New Material @

No. Color Description
2 B Stesl 5 235

Material Constants

Moduluz of elasticity E: 210000.0 | [NAmm?]
Shear modulus G: 80769.25 ¢ | [M/mm]
Puoizson's ratio v 03005+ | [1]
Specific weight ¥: TRE0 x| [kMNAm]
Coefficient of thermal expanzion o | 1.2000E-05:5 x| [17K]
Partial safety factor T 100 [
Material Model

Standard -

Comment

-
ﬂ ok ][ Cancel ]

Lo A

Figure 4.21: Dialog box New Material

1.2 Materials x
==l e S e o H e R A%
B [ C [ D [ E [ F [ G -
Material Material Modulus of Elasticity | Shear Modulus |Poisson’s Ratio | Specific Weight | Coeff. of Th. Bxp. | Partial Factor
No. Description E [kN/cmZ] G [kN/cm2] v[] 7 kMN/m 2] a [1/K] T[]
| Glulam Timber GL28h | DIN 1052:2008-1..] 1260.00 78.00 7077 5.00 5.00E-06 1.30
2 |H Poplar and Coniferous Timber C24 | (INO 1100.00 69.00 6.571 420 5.00E-06 1305
3 | Glulam Timber GL24h | DIN 1052:2008-12 1160.00 72.00 7.056 5.00 5.00E-06 1.30
4 | Steel 5 235) DIN 18800:1990-11 21000.00 8100.00 0.236 78.50 1.20E-05 1.10
5
[ -
< [ T ] r
Nodes lMaterials lCmss-Sections lMember End Releases lMember Eccentricities lMember Divisions lMembers lNodaI Supports J | ‘ > | 4}

Material Description (F7 to import material from library)

Figure 4.22: Table 1.2 Materials

Material description

Any name can be chosen for the Description of the material. When the entered name corre-
sponds to an entry of the library, RSTAB will import the material properties. The import of ma-
terials from the library is described later.

Modulus of elasticity E
The modulus of elasticity describes the ratio between normal stress and strain.

To adjust the settings for Materials, click Units and Decimal Places on the Edit menu, or use
the corresponding button.
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Shear modulus G
The shear modulus G is the second parameter used to describe the elastic behavior of a linear,
isotropic and homogenous material.

The shear modulus of the materials listed in the library is calculated according to Equation 4.1
from the modulus of elasticity E and the Poisson's ratio v. Thus, a symmetrical stiffness matrix is
ensured for isotropic materials. The shear modulus values determined in this way may slightly
deviate from the specifications in the Eurocodes.

Poisson's ratiov

The following relation exists between elastic and shear modulus and the Poisson's ratio v.

E=2G(1+v)

Equation 4.1

When you define the properties of an isotropic material manually, RSTAB will determine auto-
matically the Poisson's ratio from the values of elastic and shear modulus (respectively shear
modulus from modulus of elasticity and Poisson's ratio).

Generally, the Poisson's ratio of isotropic materials is between 0.0 and 0.5. Therefore, for a val-
ue higher than 0.5 (for example rubber) we assume that the material is not isotropic. Before
the calculation starts, a query appears asking if you want to use an orthotropic material model.

Specific weight y
The specific weight y describes the weight of the material per volume unit.
The specification is especially important for the load type 'self-weight'. The model's automatic

self-weight is determined by the specific weight and the cross-sectional areas of the members
used.

Coefficient of thermal expansion a
The coefficient describes the linear correlation between changes in temperature and axial
strains (elongation due to heating, shortening due to cooling).

The value is important for the load types 'temperature change' and 'temperature differential'.

Partial safety factor yu

The value describes the safety factor for the material resistance. Therefore the index M is used.
Use the factor ym to reduce stiffness for calculations according to second-order and large de-
formation analysis (see chapter 7.2.1, page 172).

Do not confuse the factor yw with the safety factors for the determination of design internal
forces. The partial safety factors y on the action side take part in combining load cases for load
and result combinations.

Dlubal ———
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Material model

Two material models are available for selection in the list. The parameters of the material
Q] model Isotropic Thermal-Elastic can be defined in another dialog box that you access with a
click on the [Details] button.

Standard

The linear-elastic stiffness properties of the isotropic material do not depend on directions.
The following conditions are valid:
|zatropic Thermal-Elastic. . e E>0

Standard -

e G>0

o —1T<v

Isotropic thermal-elastic

Temperature-dependent stress-strain properties of an elastic isotropic material can be defined
in a diagram or imported from [Excel]. These properties will be considered for member and
surface elements subjected to thermal load (changes or differences in temperature).

Material Model - Isotropic Thermal-Elastic | Cr-Mo Steel Cr 2 1/4 ==
Settings Temperature Diagram
Temperature Modulus of Elast. | Shear Modulus Poisson's Ratio | Coeff. of Th. Bxp. | | Temperature - Cosfficient of Thermal Expansion
T[C] E kN/em?] G [kN/em?] vH a[1/K]

1 -200.0 22477740 864527 0.300 1.2000E-05

2 -1290 220640.0 B84861.5 0.300 1.2000E-05 £

3 -70.0 216503.0 832704 0.300 1.2000E-05

4 210 210987.0 81148.8 0.300 1.2000E-05

5 93.0 2054710 73027.3 0.300 1.2000E-05

[ 149.0 2027130 77966.5 0.300 1.2000E-05

7 2040 198576.0 763754 0.300 1.2000E-05

8 260.0 1951280 75049.4 0.300 1.2000E-05

9 3160 1309920 734583 0.300 1.2000E-05

10 3710 186855.0 71867.1 0.300 1.2000E-05

il 4270 1813330 637456 0.300 1.2000E-05

12 4820 176512.0 67889.2 0.300 1.2000E-05

13 538.0 169617.0 65237.3 0.300 1.2000E-05

14 593.0 1634120 62850.6 0.300 1.2000E-05

15 £49.0 1851380 59668.3 0.300 1.2000E-05

T +T
Parameter Options
Mumber of steps: Puoiggon's ratios identical
181

Reference temperature Comment
Fieference temperature; 200 [Tl Crho Steel Cr21/4
El

Figure 4.23: Dialog box Material Model - Isotropic Thermal-Elastic

The Reference temperature defines the stiffnesses for those members that do not bear any
temperature loads. For example, when a reference temperature of 300 °C is set, RSTAB applies
to all members the reduced modulus of elasticity of this point of the temperature curve.

With the setting in the dialog section Options you decide if identical Poisson's ratios are applied
to the complete temperature diagram. Remove the checkmark to access the table column
Poisson's Ratio when you want to enter individual entries.

Click the [Save] button in the dialog box to save the stress-strain diagram so that you can use it
for other models. Use the [Load] button to import user-defined diagrams (see Figure 4.24).
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Load Dialog Box Data @

Name

Structural Steel 5 355

1.4571 [hot-ralled steel] -
1.4571 [rebars, round steel, -beams
Structural Steel 5 235

Structural Steel 5 275

Struch
Structural Steel 5 420
Structural Steel 5 460

]

[ (0] 8 ] [ Cancel

L A

Figure 4.24: Dialog box Load Dialog Box Data

Material Library

The properties of many materials are stored in a comprehensive database that can be extend-
ed.

Open the library

To access the library, click the [Material Library] button (cf. Figure 4.21, page 46) in the dialog
box New Material. You can open the database also in table 1.2 Materials (cf. Figure 4.22, page
46): Place the cursor into table column A and click the button [...] shown on the left, or use the
function key [F7] on the keyboard.

i Material Library ===

Fitter Material to Select
M aterial categary group: M aterial Description Standard i
Ol ~ | | Steel 5 235 B EN 10025-2:2004-11 E
I Stesl S 275 B EN 10025-2:2004-11 1
Material category: -
W Steel v || Steel S 450 B EN 10025-2:2004-11
W Stesl S 275N B EN 10025-3:2004-11
Standard group:
W Steel S 275 ML B EN 10025-3:2004-11
EEn T M Steel 5 355N B EN 10025-3:2004-11
Standard: W Stesl S 355 ML B EN 10025-3:2004-11
Al - (I SteelS 420N B EN 10025-3:2004-11
W Stesl S 420 ML B EN 10025-3:2004-11
W Stesl S 460N B EN 10025-3:2004-11
W Stesl S 460 NL B EN 10025-3:2004-11
W Stesl S 275 M B EN 10025-4:2004-11
[ Include invalid... W Stesl S 275 ML B EN 10025-4:2004-11 e
[ Favarites anly... ) K
Material Properties. Steel 5 355 | EN 10025-2:2004-11
E Main Properties
Modulus of Elasticity E 210000.000 | MPa
Shear Modulus G 80769.200 | MPa
Poisson’s Ratio v 0.300
Specific Weight r 78.50 | kN/m?
Coefficient of Thermal Expansion o 1.2000E-05 | 17K

[ Additional Properties

Coefficient for Limiting Stresses of Welds w 0.200
Comelation Factor for Fillet Welds Bw 0.500
[ Thickness Range t <= 40.0 mm
Uttimate Strength fu 510.000 | MPa
Yield Strength Fy 355.000 | MPa
[ Thickness Range t > 40.0 mm and t < 80.0 mm
Uttimate Strength fu 470.000 | MPa
Yield Strength Fy 335.000 | MPa

Ok ] [ Cancel

L A

Figure 4.25: Dialog box Material Library
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Select a material from the list Material to Select and check the corresponding parameters in the
lower part of the dialog box. Click [OK] or [] to import it to the previous dialog box or table.

Library filter

As the material library is very large, you find various selection options available in the dialog
section Filter. You can filter the material list according to Material category group, Material cate-
gory, Standard group and Standard. In this way, you can reduce offered data.

Material category:

Cal ivi

[ Concrete
[Lightweight Concrete
W Steel
W Steel [Steel Humbers)
[ 5tainless Steel
[ 5tainless Steel [Steel Mumbers)
[H Softwood Timber
W Hardwaood Timber
[ Glulam
[ Board Material
§ [ Timber ace. ta Non-Euopean Standards
Fiter Ot azonm

Material category group: [ Alurninium

OGlass
Dl - OFai
OGas

[ Concrete M 5ol

W Metal [ Cast Iran

[ tetal (Key Humbers) [ Cable

& Timber W Reinfarcing Steel

Ot azonm W Frestressing Steel

[ Glass and Fail [E Copper

OGas [H Copper (Copper Numbers)
W Sail [ tetal [Stress-Strain-Diagram)

Figure 4.26: Filter for Material category group and Material category

Create favorites

Often, the use of a few materials is already sufficient for daily engineering work. You can mark
these materials as your favorites. Use the button [Edit Favorites] (see Figure 4.28) to open the
dialog box for defining preferred materials.

Filter Material Library - Favorites.
M aterial categary group: M aterial Description Standard i
@ Concrete - @ Conerete C12415 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete C16/20 B EM 19932-1-1:2004/4C:2010
ilatcislcaizogn) [ Concrete C20/25 B EN 1992-1-1:2004/4C:2010
OConcrete ¥ | || @ Concrete C25/30 B EM 193241
Standard group: - Lo JENR8S2-1-1:200 .
[1| @ Conerete C35/45 B EM 19932-1-1:2004/4C:2010 L
EREN 7| |0| B Corerete C40/50 B EN 199211:2004/4C200 |
Standard: [[J| @ Cancrete C45/55 B EN 1932-1-1:2004/AC:2010
Al - [1| @ Conerete C50/50 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete C55/57 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete CEO/75 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete C70/85 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete £20/95 B EM 19932-1-1:2004/4C:2010
[1| @ Conerete £904105 B EM 19932-1-1:2004/4C:2010

EEE Dl
Figure 4.27: Dialog box Material Library - Favorites (dialog section)
The dialog box looks like the material library. You can use the filter options described above. In

the dialog section Material Library - Favorites, you can select your preferred materials by ticking
their check boxes. To change the sequence of materials, use the buttons [A] and [V].
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After closing the dialog box, the material library presents a clear favorites overview as soon as
you activate the option Favorites only.

- \
i Material Library [

Fitter Material to Select
Material category group: M aterial Description Standard
Ol + | | Conerete C12/15 B EN 1932-1-1:2004/AC:2010
[ Concrete C20/25 B EN 1932-1-1:2004/AC:2010

M aterial categony: B Conar B
mE v | M Steel 5 235 I EN 10025-2:2004-11
S g I Stesl S 275 B EN 10025-2:2004-11

Al - W Stesl S 355 B EN 10025-2:2004-11
Standard:

All -

[T Include irvalid...
Favorites only... | ) -

Material Properties. Concrete C30/37 | EN 1992-1-1:2004/AC:2010
E Main Properties -
Modulus of Elasticity E 33000.000 | N/mm2
Shear Modulus G 13750.000 | N/mm2
Poisson’s Ratio v 0.200
Specific Weight T 25.00 | kN/m?
Coefficient of Thermal Expansion o 1.0000E-05 | 1/°C

[ Additional Properties

Characteristic Cylinder Compressive Strength Fex 30.000 | N/mm2 =
Characteristic Cube Compressive Strength Feuk 37.000 | N/mm2 1
Mean Cylinder Compressive Strength fem 38.000 | N/mm2

Mean Auxial Tensile Strength Fotm 2.500 | N/mm2

5% Fractile of fxial Tensile Strength Fetk:0.05 2.000 | N/mm2

95% Fractile of Axal Tensile Strength Fetk:0.35 3.800 | N/mm2

Mean Secant Modulus of Blasticity Ecm 33000.000 | N/mm2

Uktimate Strain for Pure Compression Ect -2.200E-03

Uttimate: Strain at Failure Eclu -3.500E-03

Parabola Exponent n 2.000

Uktimate Strain for Pure Compression &2 -0.002 e

Ok ] [ Cancel

" 4

Figure 4.28: Dialog box Material Library with option Favorites only

With the check box for Include invalid in the Filter dialog section you can decide if materials of
'old' standards also appear in the library.

Add materials to library

The Material Library can be extended. When a new material is added, it can be used for all
available models.

Click the [New] button in the library (to the right of the [Favorites] button, see Figure 4.28). The
dialog box New Material opens (see Figure 4.29). You can see that parameters of the entry se-
lected in the list Material to Select are preset. So creating a new material is easier when you
choose a material with similar properties before you access the dialog box.

I Program RSTAB © 2013 Dlubal Engineering Software




4 Model Data

IR
I
Dlubal —

Engineering Software

-
New Material

[S5)

Material Description

Steel 5 235 [reduced)

Fitter
M aterial category group:

[ Metal

Material category

M Steel

Standard group:
B EN

Standard:
B EN 10025-2:2004-11

[] Favarite

Material Properties.

Bl Main Properties
Modulus of Elasticity E
Shear Modulus G
Paisson’s Ratio v
Speciic Weight i
Coefficient of Thermal Expansion o

- @@

Partial Safety Factor M
Bl Additional Properties
. Coefficient for Limiting Stresses of Welds Cw
[ Thickness Range t < 40.0mm
Uttimate Strength fu
Yield Strength Fy
M [ Thickness Range t > 40.0mm and t < 100.0mm
Ultimate Strength Fu
Yield Strength Fy
-
Comrent: Feduced material properies

20000.00 | kN/cm?2
8000.00 | kN/cm2
0.300
78.50 | kN/m?
1.2000E-05 | 17K
1.00

0.550

33.00 | kN/em?2
22.00 | kN/em?2

L

Figure 4.29: Dialog box New Material

Use the buttons shown on the left to create and edit categories.

-

Edit Material Category

[S)

Description
Concrete
Lightweight Concrete

eel (Steel Numbers)
Stainless Steel

Softwood Timber
Hardwood Timber
Glulam

Board Material

Timber acc. to Non-Euro
Masonry

Aluminium

Glass

Fail

=

Stainless Steel (Steel Nu 3

Material Category Data
A . .
i Drescription: Material Category Group:
Steel [ tetal
K
(] 8 ] [ Cancel

Lo

Figure 4.30: Dialog box Edit Material Category

To adjust the sequence of entries, use the buttons [A] and [V].

Saving user-defined materials

RSTAB 8.01\General Data.

Enter the Material Description, define the Material Properties, and assign the material to the ap-
propriate categories for Filter functions.

If you use customized materials, you should save the file Materialien_User.dbd before in-
stalling an update. You can find it in the master data folder of RSTAB 8 C:\ProgramData\Dlubal\
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4.3

General description

Cross-sections

Before you can enter a member, a cross-section must be defined. The cross-section properties
and material characteristics that are assigned determine the stiffness of the member.

Each cross-section has its own Color that can be used in the model to represent different pro-
files. Colors are controlled in the Display navigator with the option Colors in Rendering Accord-
ing to (see chapter 11.1.9, page 268).

You do not have to use each defined cross-section for input in the model. Thus, when model-
ing the structure, it is possible to make experiments without deleting cross-sections. Please
note, however, that the cross-sections cannot be renumbered.

To represent a tapered beam, you have to define different start and end cross-sections for the
member. RSTAB determines the variable stiffnesses along the member automatically.

p
New Cross-Section

No. Color Cross-Section Description

G | IPE 270 | Ewronarm 19.57
Crozz-Section Properties | Batation | I odify

Cross-Section Properties

(0] (e ) (] [ ]
ENENEY

IPE 270 | Eurenorm 18-57

EE

Moments of inertia

Tarsioh J: 16.00 5 |+| [em#]
Bending Iy : 5790.00 > ¢ | [cm*]

Iz : 42000 - | [cm#]

Cross-sectional areas

: 5 S
Auial A 4590+ | [emi] 5] ¥
Shear By 2300 | [emi]

6.6

ba: 165812 [em?] ]
Inclination of principal axes

w [

Angle

Overall dimensions [for non-uniform temperature loads)

- =

[mm]

wian b [ 0 EEEEE
Depth h: [rm]

Material

W 3| Stesls 235 | EM 10025-2:2004-11 -
Comment

@&l

0K ] [ Cancel ]
\ J
Figure 4.31: Dialog box New Cross-Section, tab Cross-Section Properties
1.3 Cross-Sections x
I E | €0 | [F (= [E ¥ a3 | [FE ESEeEa PARLEELEARL
B_ [ € [ D [ E [ F [ 6 [ H [ 1 T J ]
Section Cross-Section Material Moments of Inertia [cm4] Cross-Sectional Areas [cm<] Principal Axes | Rotation |[—
No. Description Mo. TorsionJ | Bending |y | Bending Iz Hdal A Shear Ay | Shear Az o] o' ]
[ T [W 1645 | AISC 3 Jl 2 46.20| 24391.16 1365.24 85.81 4313 3414 0.00 0.00 | =
2 |CJT w640 AISCS o 2 3288| 21860.79 1202.91 76.13 3850 021 0.00 0.00
3 |W® Crcle 300 I 4 | 795215603. | 397607801. | 397607801. | 70685.83 | 59903.25| 59903.25 0.00 0.00 |—
4 |WB T-Rectangle 20435 H 3 60029.02| 71458.33( 2333333 700.00 583.33 583.33 0.00 0.00
5 |M@ SHS =x0.125/A5C13 [ 2 118.21 74.09 74.09 839 419 419 0.00 0.00
6 |H@ cHs 55610258 A5C [l 2 1259.22 631.10 631.10 2774 13.77 1377 0.00 0.00
7 |MT waa1lAScy m 2 11.65 313422 406.66 35.74 227 1210 0.00 0.00| -
4 | [ b
Nodes | Materials | Cross-Sections ll‘u‘lember End Releases lMember Eccentricities lMember Divisions lMembers lNodaI Supports J | ‘ 2 |>|

Cross-section description (F7 to import cross-section from library)

Figure 4.32: Table 1.3 Cross-Sections
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You do not need to enter the cross-section properties manually. RSTAB provides an extensive
and extendable cross-section library as well as import options.

Cross-section description

The Cross-Section Description can be selected freely. When the entered cross-section name cor-
responds to an entry of the cross-section library, RSTAB will import the cross-section parame-
ters. In this case, it is not possible to change the values for the Moments of Inertia and the area
Axial A. For user-defined cross-section descriptions you can enter constants and cross-section
areas manually.

The characteristic values of parameterized cross-sections are also imported automatically. For
example, when you enter "Rectangle 80/140", the cross-section parameters of this cross-
section will appear.

The selection of cross-sections from the library is described later.

Itis also possible to use a rigid dummy cross-section to model couplings. RSTAB applies stiff-
nesses to this cross-section type like for a coupling member. Enter the name Dummy Rigid as
description for the cross-section without defining the cross-section values in detail. In this way,
you can use members with a high degree of stiffness, taking account of releases or other mem-
ber properties. A new variant in RSTAB 8 is the member type Rigid Member (see page 75), so
the definition of a Dummy Rigid is no longer necessary.

Material no.

The cross-section's material can be selected from the list of already defined materials. The as-
signment is made easier by material colors that are used by default for the rendered graphical
representation.

In the dialog box New Cross-Section, you can see three buttons below the material list. Use
these buttons to access the material library, to create a new material or to edit materials.

For more detailed information about materials, see chapter 4.2, page 46.

The option Hybrid available in the dialog box for rectangular timber cross-sections can be ac-
cessed only for parameterized timber profiles. Use this option to assign specific material prop-
erties to cross-section elements if different material grades are provided (for example timber of
low class for webs).

With a click on the [Edit] button you can open the dialog box Edit Hybrid Material.

Edit Hybrid Material -
- A ] B

Part
No. Material description

Ref
Mat.

[ 3 - Glulam Timber GL24c | EN 1194:1999-04 b1
4 - Coniferous Timber C30 | DIN 1052:2008-12 ~ O

1 Concrete C30/37 DIN 1045-1:2008-08 1

2 Steel 5235 DIN 18800:1990-11
3 Glulam Timber GL24c  EN 1154:1535-04 =

4 | Coniferous Timber C30 | DIN 1052:2008-12

e = E] &
(] 3 ] [ Cancel ]

L 4

Figure 4.33: Dialog box Edit Hybrid Material
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Assign materials to the single cross-section parts according to the graphical scheme. They can
be selected from the list. One of the materials must be defined as Reference Material used to
determine the ideal cross-section properties.

Moments of inertia

The moments of inertia are required for the cross-section stiffness: The torsional constant J de-
scribes the stiffness against rotation about the longitudinal axis. The second moments of area
lyand I, describe the stiffnesses against bending about the local axes y and z. Axis y is consid-
ered to be the “strong” axis. The local cross-sectional axes are shown in the dialog graphic of
the dialog box New Cross-Section.

The moments of inertia for unsymmetrical sections are displayed about the cross-section's
principal axes u and v.

Moments of inertia as well as cross-sectional areas can be adjusted with the help of factors in
the dialog tab Modify. In the table, you can access the tab with the [...] button that appears
when you click into the table cell.

Cross-Section Properties | Rotation | Modify
Modify Cross-Section Properties via Factor

Moments of inertia

(Original Multiplier factor Modified
[em#] [l [em®]
J: B6.70 WE 3335
ly: 33740.00 1.0005 33740.00
lz: 1E76.00 1.00= 1676.00

Cross-sectional areas

(Original Multiplier factar todified
lem?] [l lem?]
A 48.80 1.005 > 98.80
By 46.35 1,005 46.35
Azl 3962 1,005 3962

Figure 4.34: Dialog box New Cross-Section, tab Modify
With the entry in Figure 4.34, RSTAB considers the torsional constant only with 5 %.

Cross-sectional areas

The cross-section parameters of the cross-sectional areas are subdivided into the total area
Axial A and the shear areas Shear A, and A..

Shear area A, relates to the moment of inertia I, shear area A; relates to |l,. Using a correction
factor k we see the following correlation existing between the shear areas A, and A; as well as
the total area A.

Equation 4.2

« :i'J.J.Q%y(X) A

y/z =2
2y At
Equation 4.3
where A Total area of cross-section
Ly Moments of inertia of cross-section
Qziy0 Statical moments of cross-section at location x
tw Width of cross-section at location x

I Program RSTAB © 2013 Dlubal Engineering Software 55

Dlubal ———



IR
4 Model Data .

Dlubal —

Engineering Software

Shear areas Ay and A; affect the shear deformation which should be taken into account espe-
cially for short, massive members. When the shear areas are set to zero, the influence of shear
will not be considered. Parameters can also be controlled in the dialog tab Global Calculation
Parameters of the dialog box Calculation Parameters (see Figure 7.14, page 176). If extremely
low values are set for shear areas, numerical problems may occur because the shear areas are
contained in the denominator of equations.

Select the values for cross-section areas realistically. Extreme differences in the cross-sectional
areas of cross-sections involve significant differences in stiffness that may lead to numerical
problems when solving the equation system.

Angle of principal axes a

The principal axes are described with y and z for symmetrical sections, and with u and v for un-
symmetrical sections (see above). The rotation angle of principal axes o describes the position
of the principal axes in relation to the standard system of coordinates for symmetrical sections.
For unsymmetrical sections it is the angle between the y-axis and the u-axis (see graphicin the
left margin above). This angle is defined clockwise as a positive angle. When symmetrical
cross-sections are set, angle o is 0. The inclination of principal axes for sections from the library
cannot be edited.

The angle of rotation for the principal axes is determined by the following equation:

2-1
tan2g = — %=
Z_Iy

Equation 4.4

When you work with 2D models, only 0° and 180° are allowed to be set as cross-sectional an-
gles of rotation.

Cross-section rotation o'

The angle of rotation o' describes the angle about which the sections of all members using
that cross-section are rotated. This angle represents a global cross-sectional angle of rotation.
In addition, each member can be rotated separately about a member rotation angle .

Moreover, the dialog tab Rotation provides the option to Mirror nonsymmetrical cross-
sections. Use this option for example to put an L-section into the correct position.

General | Fotation | Modify L 100x50x6 fy

Cross-Section Rotation . 50.0

Fotation about -axis
Angle o 0.005+ 11

Mirror [for nonsymmetrical cross-zections)
| About y-ariz

About z-axis

100.0

fro]
) & E T E = ([«

Figure 4.35: Dialog box New Cross-Section, tab Rotation

When you import a cross-section from the cross-section library or SHAPE-THIN, you do not
need to take care of the angle a'. RSTAB imports this angle in the same way as the other cross-
sectional values. For user-defined sections, however, you have to determine the angle of prin-
cipal axes yourself and to adjust it manually by means of the cross-section rotation.
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Overall dimensions

Width b and Depth h of the cross-section are relevant for temperature loads.

Cross-section library
Numerous cross-sections are already available in the cross-section data base.

Open the library

In the dialog box New Cross-Section and in table 1.3 Cross-Sections, you have direct access to
frequently used cross-section tables:

X
R - T DI T N .g.;:&cl
[B_| [ [ D [ E [ F T &6 [ H T 1 | | K I L |
aterial Moments of Inertia [cm 4] Cross-Sectional Areas [cm2]  Principal Axes| Rotation Overall Dimensions [mm]
Mo. | Torsion J | Bending |y | Bending |z | Aodal A IShear Ayl Shear Az | [] | o[ | Width b | Depth h | Comment |

New Cross-Section

No. Color Cross-Section Description @ H.HM.. . . .
7 ;
. B EEEOEEE D

General | Ratation | Madify

Figure 4.36: Buttons of frequently used cross-sections in table (above) and dialog box (below)

Use the button [Import Cross-Section from Library] to access the complete cross-section data-
base. When you work in the table, place the cursor into table column A to enable the [...] but-
ton which you can use like the function key [F7] to open the cross-section library.

Cross-Section Library @

Rolled Parametric - Thin Parametric - Massive Parametric - Timber

) (a])(z] [o)le](e](n]

[l fijl) e)](a] (z](e](o]lm]

l2lln) m=epllzllz]lz) (w)fa](z]lx]
EYEAFEY

EERENE

ENENEN[

%

Z.KZ. 2180, k2180 User-Defined From Cross-Section Program

L5 4

Figure 4.37: Cross-Section Library

The cross-section library is divided into several sections which are described on the following
pages.

Rolled cross-sections
The table values of many rolled cross-sections are stored in a database.

First, click one of the ten buttons to define the Cross-Section Type. Another dialog box opens
where you select the Table. Then, select an appropriate Cross-Section (see figure below).
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Manufacturer/Standard group:

All -

Manufacturer/Standard:

All -

Cross-zection shape:

All -

Cross-section note:

All
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Favorites group:
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Rolled Cross-Sections - [-Sections

=

Cross-Section Type To Select

Tes
()il I

IH
TIcs
TIvs
Tovs
I
I
Iw
Iw
Manufacturer/Standard group. THe

1] - TH

Fitter

Manufacturer/Standard

Al - Tue
Cross-section shape:

Al -

Cross-section note: I
l I He

[ includs invalid IHe

[7] Favorites aroup:
E] =d|}b &

Manufactwer/Standard *

== GOST, 1994

== GOST, 1994

Bl GB11263-98

Bl GB 1126305

= HER 5884

= HER 5884

=1 NBR 5884

) KS D 3503, 351572

) KS D 3603, 3515/

i KS D 3603, 3515/

1ol CAN/CSASIED

Iel CAN/CSASIED

Iel CAN/CSASIED

Iel CAN/CSASIED! (=

Iel CAN/CSASIED
BS 412003

i3 BS 41:2003

@ IS G 3192 (RSA)
25 B9 4-1:2003

= 15 8087983

= 15 8087383

== |5 B08:1983

== |5 B08:1983

== |5 B08:1983

== |5 B08:1983
Arcelobittal
Arcelotittal [2011)

Arcelorhittal S

To Select

Cross-Section

UBP 203x203x54
UBP 2544254163
UBP 254x254x71
UBP 254x254x85
UBP 305x305:73
UBP 305x305+88
UBP 305x305+95
UBF 305x305x110
UBF 305x305x128
UBF 305x305x143
UBF 305x305x188
UBF 305x305x223
UBF 356x368x109
UBF 356x368x133
UBF 356x368x152
UBF 356x368x174

UBP 203x203x45 | BS 4-1:2003

2058

20.02

Material

W1 - Steel § 235JR | EN 10026:1334-03 -

UBP 20320345 | BS 4-1:2003

ud

[em]

MEED

Figure 4.38: Selecting a rolled cross-section

In the dialog section Filter, you can filter library entries by different criteria: Manufacturer/Stan-
dard group, Manufacturer/Standard, Cross-section shape and Cross-section note. In this way, it is
easier to overview the offered tables and cross-sections. Displayed data can be sorted by click-
ing the headings of table columns.

If cross-sections of old standards are needed, tick the checkbox for Inclusive invalid in the dia-
log section Filter to display also such sections.

Create favorites

Preferred cross-sections can be set as favorites. To access the dialog box for creating favorite
cross-sections, use the button [Create New Favorites Group] in the right corner of the Filter dia-

log section.

Rolled Cross-Sections - I-Sections - Favorites - American Steel

Cross-Section Type Select Favorites
Table
Iw
R[N W e
Is
2l i
7w
IM
THP
Iw
Fitter
Manufacturer/Standard group:
E5 AIST -
Manufacturer/Standard
&l -
Cross-section shape:
&l -
Cross-section note:
&l
(] Inglude invalid.
g G
= (%
x

Manufacturer/Standard
= asCY
= AlSCY
= AlSCY
= AlSCY
= AISC13
IS AISC13

ard
S AM Standard
= &M Standard

Select Favorites.

(fisssssvssssSsssssssss s

Cross-Section

HD 360:147
HD 3R0x162
HD 360:173
HD 360196
HD 400x218
HD 400237
HD 400262
HD 400287
HD 400314
HD 400347
HD 400382
HD 400421
HD 400463
HD 400509
HD 4004551
HD 400:552
HD 400634
HD 400x677
HD 400744
HD 400:818
HD 400300
HD 400330
HD 400:1088

HD 380x134 | AM Standard

35.60

HD 360134 | AM Standard

ud

[em]

Figure 4.39: Dialog box Rolled Cross-Sections - I-Sections - Favorites

58

I Program RSTAB © 2013 Dlubal Engineering Software

Dlubal —



4 Model Data

IR
I
Dlubal

Parametric - Thin

sections with a check mark.

Built-up cross-sections

Engineering Software

The dialog box looks like the cross-section library. You can use the filter options described
above. In the dialog sections Select Favorites, you can choose preferred tables and cross-

After closing the dialog box, the cross-section library presents a clear overview of favorites as
soon as you activate the option Favorites group.

Rolled cross-sections can be combined by specifying parameters.

Combined Cross-Sections - I-Sections S
Cross-Section Type Combination Type 20K HE B 300 + UB 178x102x19 | Euronarm 53-62 + BS
IT Twice Spliced
T Crasswise with One Half [Left)
I H Crosswise with Dne Half (Right
i 3 Sections
* i 3 1-5ections (B)
4 Twa Interlocking Beams
Table Select
Table ’ Manutacturer/Standard Eloss—Secl\or: .
- I IFE B Euonom 1357 HE E 180
s T HE & B Euonom 5362 HE & 200 B
Manufacturer/Standard group: 1= Euro HE B 220 = .
'z
EEN « THEM B Euonom 5362 HE E 240 L h/2
HE B 250
Manufacturer/Standard HE B 200
A - HE B 300 &
HE B 320
Cross-section shape
HE B 340 -
Al -
) Table Manufacturer/Standard * || Cross-Section -
Cross-section note: |E
Al Tuc 5 BS [ UB 20360223
T IPM Arbed UB 20341 3425
T IPE Arbed UB 2031 33630 Material
THE Arbed UB 254w1 02522 1 - Steel 5 235 | EN 10025-2:2004-11 -
T HD Arbed UB 2541102425
[] Inchude ireealid...
THL Arbed UB 2544102428 o
[ Favoites group THFP Aibed UB 25dw1 46431
ein wersuch =) Tw rbed - UB 2457 = 2K HE B 300 + LIB 178102613 | Eurancm 5362 + B5

Figure 4.40: Dialog box Combined Cross-Sections - I-Sections

Use the [Save] button to save a combined cross-section. RSTAB stores it with its accurate de-
scription (for example 2IK HE B 300 + UB 178x102x19 in the figure above) in the category User-
Defined from where you can reimport it later.

Parametric cross-sections - thin

With the offered input fields you can freely define parameters for a cross-section composed of

()] o]
o]z ()]

sheets. The cross-section values will be calculated according to the theory for thin-walled
cross-sections. The theory applies only to cross-sections whose element thickness is clearly
smaller than the respective element length. If this condition is not fulfilled, define the cross-
section in the Massive category (see Figure 4.42), if possible.

Parameter a represents the weld root, not the fillet radius (see figure below).
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Welded Cross-Sections - I symmetric @

Cross-Section Type Parameters

e
\E 8.0 [mm]
o) (= ]m(m]
Bl

w0

Material

2 - Steel 5 235 | EN 10025-2:2004-11 -

15 33011E60/812/0

L 4

Figure 4.41: Input dialog box of a parameterized, thin-walled cross-section

Use the button shown on the left to import the parameters of a rolled cross-section. By using
the selection function you can avoid entering lots of parameters.

Use the [Save] button to save a parametric cross-section with its exact name, for example
IS 330/160/8/12/0 in the figure above. Click the [Load] button shown on the left to import it.

Parametric cross-sections - massive

With these input fields you can freely define the parameters of massive cross-sections (for ex-
ample reinforced concrete sections). The cross-section values will be calculated according to

the theory for massive cross-sections provided for elements with distinctive wall thicknesses.

Solid Cross-Sections - Floor Beam &J

Cross-Section Type Parameters
Al - 2

b 1200.015 ¢ [mm] b

4 220,08 [mm] r j

s [ 200 el :': =

Y % ¥
z
LSl

& (<

Material

[E1 - Conerete C30437 | EN 1932-1-1:2004/4C:2010

EE
FB 750/1200/220/250

L 4

Figure 4.42: Input dialog box of a massive cross-section
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Parametric cross-sections - timber

With the offered input fields you can freely define parameters for timber cross-sections. The
cross-section values of both solid and combined cross-sections will be calculated according to
the theory for massive cross-sections.

Timber Cross-Sections - Hollow Rectangle with Vertical Connection Lines @

Cross-Section Type Parameters

0 o
b 360.01+| [mm]
m hi: 80.05 x| [mm]
e
o
Coefficient of compliance
e [_ommEhn
=l f

&
Material
[H3 - Gluelam Timber GL24h | EN 1194:1333-04 -
Hybrid... @)
HSY 400./360/80/20/60/0.650
Ok ] [ Cancel

L S

Figure 4.43: Input dialog box of a timber cross-section

Ticking the option Coefficient of compliance allows you to determine the effective stiffnesses
for composite structural components from semi-rigidly connected cross-section elements, for
example according to DIN 1052:2008-12, 8.6.2 (3). In this case, specify the reduction factors y.

When you work with a material of the type Hybrid, use the [Edit] button to assign the proper-
ties of the cross-section parts (see Figure 4.33, page 54).
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User-Defined User-defined cross-sections

Import saved cross-section

Click the [Load] button shown on the left to open a dialog box where all cross-sections created
with the help of the Save function are displayed.

Properties of User-Defined Cross-Sections @
Table Cross-Section Description Cross-Section Properties
SHAPE-MASSIVE J 2299 [emé]
SHAPE-THIM 15415 500/200/12416/0 - 11622.70 [emé]
2IK0 15415 410/410/25/40/0
[EN - e
A 62,83 [cmi]
By 38.40 [emi]
Aa: 24,438 [emi]
o 0.00 7]
u: 1.284 [m? /m]
Type: @ Open
Clozed

Buckling Curve

According ta EM According to DIM
BCy: |C BCy: o
BCz: |c BCz: o

According to EM (fy =460 M)
BCy: |C

@ BCz: |C

(] 8 ] [ Cancel

Figure 4.44: Dialog box Properties of User-Defined Cross-Sections

Create a user-defined cross-section

Click the [Create] button shown on the left to create user-defined cross-sections.

"
Create User-Defined Cross-Section @
Table (e.g. "HPmy"} Mame (e.g. “10x10x52") Diverse Cross-Section Values
Special CS Custorn-1 Suface area A 0.000 %+ [m? /m]
Moments of Inertia 7 _
Cross-section wpe @) Open (17 by 5t enant]
. . = 4 _

Tarsion I7: R | [om] ) Closed (17 by Bredt]
Bending ly: 0005 ¢ [m?]

ke 0,002 femé] Buckling Curve

According to EM According to DIN

Cross-Sectional Areas
Axial A 00015 »| [om?]
Shear Ay 0005 ¢ [em?]

Az 00015 7| [cm?]
Principal Axis
Angle o 000+ 7]
Dimensions (for Temperature Loads) Stress Points
‘width W 0.0 x| [mm]
Height h: 0.0 [mm]
ok [ conce

Figure 4.45: Dialog box Create User-Defined Cross-Section

Enter the Table to define the place where the cross-section is managed. Specify also the Name
to describe the new cross-section. Then, enter the cross-section parameters and define the
buckling curves.
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Cross-sections from cross-section program

Itis also possible to import cross-sections from the DLUBAL cross-section programs SHAPE-
THIN and SHAPE-MASSIVE.

Please note that the cross-sections must be calculated and saved in SHAPE-THIN or SHAPE-
MASSIVE before the cross-sectional values can be imported.

Import cross-section table from ASCII file

Use the button in the bottom left corner of the library to import a complete cross-section table
from a file. The file must be a comma separated values file (CSV). Any Excel file can be saved in

this format. Make sure that the syntax of the ASCII table corresponds to the definition parame-
ters of the corresponding RSTAB cross-section table.

Example: Import of double symmetrical I-sections

The cross-sections are managed in the IS table (cf. Figure 4.41). For IS cross-sections, the fol-
lowing parameters are required: h, b, s, t, a. The table in Excel is structured as shown below

A B C D E F
1 Description h b s t a
2 Cross-sectionl 400.00 200.00 10.00 10.00 0.00
3
4
5

Figure 4.46: Excel spreadsheet with cross-section parameters

In the import dialog box, specify the directory of the CSV file. Then, use the list to select the
cross-section table where you want to manage the imported cross-sections.

Import Cross-Sections from ASCI File [&J
Import from File
C:A\Temp'S.cev E
Create cross-section table
of type: |IS - |-Section v|
j [ ak. ] | Cancel |

L S

Figure 4.47: Dialog box Import Cross-Sections from ASCII File
Finally, you find the imported cross-sections available in the category User-Defined cross-
sections (see Figure 4.44).

When importing cross-sections, RSTAB calculates the cross-section values and stress points so
that stress designs can be performed as well.
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44  Member End Releases

General description

Member releases limit the internal forces transferred from one member to others. Releases are
assigned only to member ends (nodes). They can never be assigned to other locations, for ex-
ample to the middle of the member.

Some member types are already provided with releases. A truss, for example, does not transfer
moments. A cable neither transfers moments nor shear forces. When entering data, keep in
mind that the assignment of releases is blocked for members of such member types.

MNew Member End Release @

Member End Release No.
3

Reference System

@ Local member axes xy.z
() Global axes Y Z

() Global rotated axes X" 2"

ZHH,

—

Release Conditions

Felease Spring constant Monlinearity

u Cux [kN/m] Failure i positive N B
[ wy Cuy I:I Mohe =
[ we Cuz I:I Haone =
Releaze

[T ox Cox I:I Hane =
oy By 3 0.000[2 ]| (kim/rad] [None BIE
o B ¢ 0.0001{] [khmérad] [Mane BIE

E &)
i,

Comment

o= | = —
Wy | | M =

-
(0] 8 ] [ Cancel

L A

Figure 4.48: Dialog box New Member End Release

1.4 Member End Releases x
EE EE[N€O | &= [5]] €] & 3 HEyE= F A%
[ A [ 8B [ ¢ E | F [ G 1 H -
Release Reference Huial/Shear Release or Spring [lkN/m] Moment Release or Spring kNm/rad]
No. System N Vy Vz Mt My Mz Comment
1 | Localxy.z a a ] a
[ Local xy.z o o - a
3 [ Global X.Y.Z 4 4 Yes a Scissors Scissors L
4 No 1
5 Spring constant
[ Failure if negative Vz
7 Failure if positive Vz
2 Partial activity... |
5 Diagram... e
Nodes | Materials | Cross-Sections | Member End Releases | Member Eccentricities | Member Divisions | Members | Nodal Supports | [«[»[r
Release Condition ("Y'es / 'N'o / Spring Constant / Nonlinear / F7 to select). Assign the release type to the member in Table 1.7.

Figure 4.49: Table 1.4 Member End Releases
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Reference system

A member release can be related to one of the following axis systems:
e Local member axis system x,y,z
e Global coordinate system X,Y,Z
¢ Global rotated coordinate system X',Y',Z'

Use the Display navigator or the member context menu shown on the left to display the local
member axes (see Figure 4.72, page 80).

For detailed information about the orientation of local member axes in the global coordinate
system X,Y,Z, see chapter 4.7 on page 80.

Normally, releases are related to the local axis system x,y,z. Scissors releases (see release 3 in
Figure 4.51), however, must be related to the global coordinate system. Spring constants and
non-linearities must be defined in relation to the local member axis system.

Axial/shear release or spring

To define an axial or shear force release, tick the check box of the respective internal force in
the dialog box or table. The check mark means that the corresponding internal force is blocked
at the member end because a release has been set. Look at the Member End Release dialog box:
A zero value is shown for the constant of the translational spring in the input field to the right
of the check mark.

You can always change the spring constant to represent for example a semi-rigid connection.
In the table, enter the constant directly into the table column. The stiffnesses of the springs are
considered as design values.

Moment release or spring

Define releases for torsion or bending moments like releases for forces. Again, the check mark
means that the corresponding internal force is not transferred.

Elastic connections can be modeled by means of spring constants that you can enter directly.
Pay attention not to use extreme stiffness values because otherwise numerical problems may
occur during the calculation. Instead of very big or small constants, apply rigid connections (no
check mark) or releases (check mark).

The option for defining non-linear release properties is described at the end of this chapter.

Assign releases graphically

To assign releases in the work window graphically,
select Model Data on the Insert menu, point to Member End Releases and select
Assign to Members Graphically or
open the Edit menu, point to Model Data and Member End Releases, and then select
Assign Graphically to Members.

First, select a release type from the list or create a new one. After clicking [OK], members are
divided graphically at one-third division points.
g e ————

—_ o~

Multiple Selection

Select Side of Member
Member Mo, 9 |
Selected:
E3 |

Clear oK Cancel ¢

Figure 4.50: Assigning member end releases graphically
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Now, you can click the member sides to which you want to apply the selected release. To
assign the release to both member ends, click the member in its center area.

Scissors release

With scissors releases you can represent crossing of beams. For example: You have four mem-
bers connected in one node. Each of the two member pairs transfers moments in its 'continu-
ous direction’, but they do not transfer any moments to the other pair. Only axial and shear
forces are transferred in the node.

— L) e—

A
1 2
i
4
Figure 4.51: Beam crossing
New Member End Release &J

Member End Release No.
4

Reference System

) Local member axes xyp.z

2 Global ares %Y 2

) Global rotated axes ' ' 2"

ZrR

Release Conditions

Releaze

T Px Az sCizsors

[ Py Az sCizsors

0 Pz Az sCizsors

Releaze

[ Mx Ag scissors
K Az scissors
\ Mz Az scissoD

&)
Comment

-
(] 8 ] [ Cancel

L A

Figure 4.52: Dialog box New Member End Release

In this case, the release must be assigned either to members 1 and 2 or to members 3 and 4.
The other crossing member pair will be modeled as bending-resistant without release.
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Non-linearities
Non-linear properties can be assigned to member end releases. In this way, you can control
the transfer of internal forces in detail. The list of non-linearities offers the following options:
¢ Failure if internal force negative
e Failure if internal force positive
e Partial activity
e Diagram

Release Conditions

Felease Spring constant Monlinearity
ux Cux 0.00015 ] kM) [Patial activit... BIE)
T uy Buy = Mone [

Failure if negative M

M u Cuz =B Failure if EositiveN [

Releaze Diagram...

[ o« Cox = Hone =
Py Coy : 0.00075 x| (kim/rad] IFaiIure if negative My v] =)
o Coz : 0,000/ [kNmérad] [None BIE

Figure 4.53: List of nonlinear properties

In the table, release types with non-linear properties are marked in blue.

Failure if internal force negative or positive

Use the two options to control the release activity for each internal force depending on the
direction. For example, setting an axial force release with the nonlinearity Failure if positive N
makes the release effective only for negative axial forces. Thus, only tensile forces (positive) are
transferred at the member end, but no compressive forces (negative).

The remaining entries of the Nonlinearity list offer detailed modeling options for release prop-
erties. To access the options, use the [Edit] dialog buttons to the right of the list or the [¥] but-
ton in the table (see Figure 4.49, page 64).

Partial activity

Nenlinearity - Partial Activity - Member End Release u-x &J

Release activity in positive zone Activity Diagram
) Complete N
~) Fixed from release displacement L+
@ Tearing from releasze force M+
) Yielding from release force M+

_ Failure

Felease force M+ - 870000015+ | [kN]

U +ly

Slippage Us+: 00001 [m]
Release activity in negative zone
‘@ Complete

*) Fixed from release dizsplacement u-

_) Tearing from releaze force M-

) Yielding from release force M- H

_ Failure

Slippage Us- © 00005 x| [m]
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Figure 4.54: Dialog box Nonlinearity - Partial Activity
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The activity of the release can be defined separately for the positive and negative zone. In addi-
tion to full effectiveness or failure, the release can loose its effect when a certain displacement
or rotation is reached. Then, it begins to act as a fixed or rigid connection. Also Tearing (no in-
ternal force will be transferred anymore after exceeding a certain value) and Yielding (internal
forces will be transferred only up to a certain value also in case of larger deformations) are pos-
sible in combination with a Slippage.

The limit values can be defined in the input fields below. In the dialog section Activity Diagram,
the release properties are shown in a dynamic graphic.

Diagram
Nenlinearity - Diagram - Member End Release u-z &J
Positive Zone Diagram
Murmber of | | w=z [m] Pz [kN] =
steps: 5 1 0.000 0.000
2 0.020 8.000
3 0.050 17.000
Diiagram after last | 0.100 25.000
step: [ 5 30.000
Tearing
@ “Yielding
Continuous
Stop
Negative Zone Uz +Uz
Symmetric about the uz[m] Pz [kN]
origin 1 0.000
Number of ﬂ& -8.000
steps: 5 3 -0.050 -17.000
4 -0.100 -25.000
Dizaram after last 5 0150 30,000
step: ———
Tearing
Yielding
Continuous
@ Stop
Pz
2] @) B)&E) @)= =) 0K [ Conce

Figure 4.55: Dialog box Nonlinearity - Diagram

The activity of the release can be defined separately for the Positive and Negative Zone. First,
enter the Number of steps (that means definition points) represented in the diagram. Then, you
can enter the abscissa values of the internal forces with the assigned displacements or rota-
tions into the list to the right.

You find several options for the Diagram after last step: Tearing for failure of the release (no
internal force will be transferred any longer), Yielding for restricting the transfer to a maximum
allowable internal force, Continuous as in the last step or Stop for restricting to a maximum al-
lowable displacement or rotation followed by a fixed or rigid release activity.

In the dialog section Diagram, the release properties are shown in a dynamic graphic.
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Example: rafter roof

Figure 4.56: Rafter roof

A planar system is used. The release must be defined as follows:
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I
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1.4 Member End Releases x
| EEEE IO | EHEE[E K= | FE EaEE A%
A B C 1] E -
Release Reference Release or Spring [lkM/m] [lkNm./rad] F
No. System N Vz My Comment |
ﬁj locaxyz a m] 2 )
2 |
3 | -
MNodes lMateriaIs lCross-Sections lMember End Releases ll'u'lember Eccertricities lMember Divisions lMembers lNodaI Supports J I<| 4 | » | 3]
Release Condition ("Y'es / 'N'o / Spring Constant / Nonlinear / F7 to select). Assign the release type to the member in Table 1.7.
Figure 4.57: Table 1.4 Member End Releases
Now, the release type can be assigned to the members.
\2
3
1
4
1.7 Members x
HE = | o D6 | [ (=] (5] | ] | K E=3e ||| S &[] | 2 fx %
A [EE_C D [ _E F | G [ 1 J K L M N -
Member Mode Mo. |Member Rotation | Cross-Section Mo. | Release MNo. \Eccentr. | Division | Taper Length Weight F
No. | Member Type | Statt | End | Type End | Start | End Mo. Mo. | Shape L [m] W ka]
1 2 | Angle 1 @10 0 0 0 5.000 720 2
2 3 | Angle 1 @10 0 0 0 4.220 608 (7
3 4 | Angle 1 o)1 0 0 0 4.220 60.8
4 5 | Angle 1 ob1fo 0 0 0 5.000 720
2 4 | Angle 1 01N 1/ 0 0 6.407 23|~
| 1 ] ¢
MNodes lMateriaIs lCross-Sections lMember End Releases lMember Eccertricities lMember Divisions lMembers lNodaI Supports J I<| 4 | 3 | 3]

MNumber of node

Figure 4.58: Graphic and table 1.7 Members

Figure 4.59: Moment diagram in load case Self-weight
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4.5 Member Eccentricities

General description

The length of a member in RSTAB corresponds to the distance between two nodes defining
the member. However, in some modeling situations (connections of cross-sections or down-
stand beams), reality is represented only to a certain degree. With member eccentricities you
can connect members eccentrically due to special member end sections. In this way, you can
reduce for example design moments on horizontal beams for frames with big column cross-
sections. Member eccentricities are taken into account by a transformation of the degrees of
freedom in the local element stiffness matrix of the respective member.

To check the entered eccentricities, use the photo-realistic imaging of the 3D rendering.

Dlubal —

®  solid Display Model
@ Solid Transparent Display Model

MNew Member Eccentricity

(S

Member Eccentricity No.
1

Absolute Offset Relative Automatically Offset

Feference system Cross-section alignment

Azial offzet from adjoining

Abzolute Offset

) Local xy.z
@ GlobalxY Z

Member start i

i 150015 ;
=t frm] [ Transverse offset fram cross- z
B 0.0:]| [mm] section of ather member

Bi.Z ATE0E [mm] Member Mo.: !

1

Member end | Axiz offzet

g 0.05 x| [rm]

¥ 0.0 | [mm]

gz 0.0 x| [mm]

members at:
[ Member start Comment
[ Member end -
=4 aK ] [ Cancel ]
Figure 4.60: Dialog box New Member Eccentricity
1.5 Member Eccentricities x
EEE EFI3EO X+ FE I EE@ELAR
[ A mmm c [ b0 [E[ F [ & [ H [ T [ J [ K [ L -
Eccen. [Reference| Member Start - Eccentricity [mm] | Member End - Eccentricity [mm] | Cross-Section Alignment | Transverse offset from cross-section of ar
Na. System 2ix eiY eiz 2jx ejY ejz y-fuds z-fods Object Type | Object No. y-fodis
[ Global 0.0 00| oo 0.0 0.0|Mdde | Botiom (+z) | None 12 | Middle L
2 | Global 150.0 0.0 -1750( 0.0 0.0 0.0 | Middle Middle None 0 | Middle 1
3
4
5 -
1] 1 ¢
Nodes | Materials | Cross-Sections | Member End Releases | Member Eccentricities | Member Divisions | Members | Nodal Supports | [«[»[r

Eccentricity on start of member. Assign the eccentricity type in Table 1.7 to the member.

Figure 4.61: Table 1.5 Member Eccentricities

Reference system

e Local member axis system x,y,z
e Global coordinate system X,Y,Z

axes x,y,z (see Figure 4.72, page 80).

A member eccentricity can be related to one of the following axis systems:

Use the Display navigator or the context menu of the member to display the local member
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Eccentricity for member start/member end

In the dialog section Absolute Offset, respectively in table columns B to G, you define the ec-
centricities for the Member start i and the Member end j. The distances are related to the select-
ed axis system indicated by the upper- and lower-case indexes which are also shown in the di-
alog graphic.

In the dialog box, you can use the buttons [¥] and [A] to transfer the values from one side to
the other.

Cross-section alignment

In the dialog section Relative Automatically Offset, use the nine selection options to define the
cross-section point relevant for the determination of the eccentricity. In the table, specify the
position of the point in columns H and I. The point defines the distance by which the cross-
section is shifted on the start or end node.

By defining the point in the middle of the top flange, as shown in the picture on the left, you
can attach for example a horizontal beam with its top edge to a column by flush connection
(without extension).

Transverse offset from cross-section of other member

With a Transverse offset you can arrange a member parallel to another member in a particular
distance. Select the number of the relevant member from the list. You can also use the [\]
function to select it in the work window. The eccentricity is determined from the Cross-section
alignment defined above and the Axis offset as a result of the cross-sectional geometry that you
define by the nine check boxes. In the table, define the axis offset in columns L and M.

For example, when the points are defined on the top cross-section border and in the cross-
section center as shown in the figures on the left, a horizontal beam cross-section is connected
with its upper chord to the head of a column by flush connection.

Axial offset from adjoining members at

The last option in the dialog section Relative Automatically Offset allows you to connect easily
for example a member eccentrically to a flange of a column. The offset can be arranged sepa-
rately for Member start and Member end. The eccentricity is determined automatically from the
cross-section geometry of the adjacent members. In the table, assign the axial offset in col-
umns N and O.

The dialog graphic Axial Offset is interactive with the input, illustrating the effectiveness of the
selected check boxes.

You may prefer the input in the dialog section Relative Automatically Offset because you can di-
rectly adjust the eccentricities when cross-sections are changed. RSTAB takes into account
modified cross-section dimensions automatically.

Assign eccentricities graphically

Furthermore, eccentricities can be assigned to members graphically in the work window. To
open the corresponding dialog box,

select Model Data on the Insert menu, point to Member Eccentricities and select
Assign to Members Graphically or

open the Edit menu, point to Model Data and Member Eccentricities, and then select
Assign Graphically to Members.

First, define the reference system and the eccentricities.

After clicking [OK], members are divided graphically at one-third division points. Now, you can
click the member sides to which you want to apply the eccentricity (see Figure 4.50, page 65).
To assign an eccentric connection to both member ends, click the member in its center area.

Dlubal ———
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46 Member Divisions

General description

Member divisions are used to define points on members for which internal forces and defor-
mations are displayed later in the results tables and the numerical printout. A member division
has neither influence on the determination of extreme values nor on the graphical results dia-
gram (RSTAB internally uses a more refined partition). Therefore, in most cases, member divi-
sions are not required.

New Member Division ﬁ
No. Number of Intermediate Points
1 =
Relative Distance Member Division
%1 0.20004
xI 0.4000% »
| 2 3 4
xz | 06000[2] g4 Lo
x4 0.8000 5+ X
=11, x|
%
X3
X
Comment
-
[ oK ] [ Cancel ]
Figure 4.62: Dialog box New Member Division
1.6 Member Divisions x
FEEES EEIE| | E[=]E ¥ | HE L SMeEd E AR
B [ € [ b [ E [ F [T & [ H T v T 4 T K -
Divigion | Number of Relative distance of point from the member start
No. Pairts x1 Xz x3 x4 X5 X& x7 X2 x3 Comment
M3 | 02500 05000 0.7500
2 5 0.1000| 02000 0.3000| 04000 05000 0.6000| O0.7000| O0.8000| 0.5000 =
3
4
5]
[ -
Nodes | Materials | Cross-Sections | Member End Releases | Member Eccentricities | Member Divisions | Members | Nodal Supports | [«[»[r
MNumber of dividing peints

Figure 4.63: Table 1.6 Member Divisions

Number of points

You can enter a maximum number of 99 division points in the dialog box. An entry divides the
member into the desired number of equidistant points.

Relative distance of point from member start

When you create a new division in the dialog box, the distances of three intermediate points
are preset. They represent the relative distances in the interval of 0 (member start) to 1 (mem-
ber end).

Itis also possible to define irregular divisions for the specified points as you can enter the rela-
tive distances freely. Only make sure that you follow the correct order of intervals: x1 < x2 < X3 ...

Moreover, any x-location on the member can specifically evaluated graphically (see chapter
9.5, page 208). Thus, in most cases entering member divisions manually with troublesome de-
termination of relative distances is unnecessary.
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47 Members

General description

The geometry of the model is defined by members. Every member is defined by a start and an
end node. By assigning a cross-section (by which also a material is defined), the member re-
ceives a stiffness.

Members can be connected with each other only on nodes. When members cross each other
without sharing a common node, no connection exists. No internal forces are transferred on
such crossings.

Graphically, you can apply members as Single or Continuous. The option Inserted Member is
described in chapter 11.4.13 on page 316.

r ™y
New Member ﬁ

General | Options | Effective Lengths | Modify Stifiness |

Member No. Member Type
137 [ Beam - =
Node No. IPE 300

Member start: 2

4

EE)
HE)
J
|

Memberend: 15

4

Member Rotation via
ode 1

() Help node Mo |73 oy =

m m
In plane: @ xy 5
Cross-Section
Membersta: [ I 1 | IPE 300 | Steel 5 235 |~

Memberend:  As member start h

Member Release

&)
&)
Member start:  None - =]

Memberend:  None M

[ OK ][ Cancel

L5 J

Figure 4.64: Dialog box New Member, tab General

1.7 Members x
=R EEIEO | FHEEE K= =L Ee | F A%
D [ E F 1 G H [ 1 J K L M N 0 P .
Member Rotation Cross-Section Mo. | Release Mo. | Eccentr. | Division | Taper | Length | Weight —
Type Stat |End| No. MNo. |Shape| L[m] | W [ka] Comment I
Angle 0 1 0 0 1250 | XZ
Angle 0 329| Y
Angle 0 0 0 0 1250 | XZ
Angle 0 329| Y
Angle 0 329| Y
Angle 0 329| Y
Angle 0 329| Y
Angle 0 0 0 0 2395| X2
Angle 0 329| Y
Angle 0 0 0 0 . 2395 X2 -
Nodes lMateriaIs lCross-Sections lMember End Releases lMember Eccentricities lMember Divisions | Members | Nodal Supports J 4] 4] v [m

Member type (F7 to select)

Figure 4.65: Table 1.7 Members
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MNew Member &1
| General | Options | Effective Lengthsl Modify Stiffnesses
Member No.
2
Member Eccentricity
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Member Division
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Figure 4.66: Dialog box New Member, tab Options

Member type

With the member type you define the way how internal forces are absorbed or which proper-
ties are assumed for the member.

Different options are available for selection in the Member Type list. Each member type has its
own Color that can be used in the model to represent different kinds of members. Colors are
controlled in the Display navigator with the option Colors in Rendering According to (see chap-

ter 11.1.9, page 268).

Member type Short description

Beam Bending-resistant member that can transmit all internal forces.
Rigid Coupling member with rigid stiffness

Truss Beam with moment releases at both ends

Truss (only N) Member with stiffness E - A only

Tension Truss (only N) with failure in case of compression force

Compression

Truss (only N) with failure in case of tension force

Buckling

Truss (only N) with failure in case of compression force > N«

Cable

Member transferring tension forces only. Calculation is performed
according to large deformation analysis.

Definable stiffness

Member with user-defined stiffnesses

Coupling rigid-rigid

Rigid coupling with bending-resistant connections at both ends

Coupling rigid-hinge

Rigid coupling with bending-resistant and hinged connection

Coupling hinge-hinge

Rigid coupling with hinged connections at both ends (only axial
and shear forces are transmitted, but no moments).

Coupling hinge-rigid

Rigid coupling with hinged and bending-resistant connection

Null

Member that will be ignored in the calculation

Spring (in preparation)

Member with spring stiffness, definable activity zones and damping
coefficients

Table 4.1: Member types
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Beam

A beam does not have any releases defined on its member ends. When two beams are con-
nected with each other and no release has been defined for the common node, the connec-
tion is bending-resistant. Beams can be stressed by all types of loads.

Rigid member

It couples the displacements of two nodes by a rigid connection. Thus, it corresponds to a
coupling member in principle (see page 77). Use a rigid member to define members with high
stiffness taking into account releases which may also have spring constants and nonlinearities.
Hardly any numeric problems will occur as stiffnesses are adjusted to the system. RSTAB shows
internal forces also for rigid members.

The following stiffnesses are assumed (applies also to couplings and Dummy Rigids):

e Longitudinal and torsional stiffness E-A=G-l=10""1 (L= member length)
e Flexural resistance E-1=10-0
e Shear stiffness (if activated) Gay=Ga,=10"- 13

Due to this type of member it is no longer necessary to define a Dummy Rigid (see page 54)
which is assigned as cross-section.

Truss (only N)

This type of a truss member absorbs axial forces in the form of tension and compression. A
truss member has internal moment releases on its member ends. Therefore, an additional re-
lease definition is not allowed. RSTAB shows you only node internal forces (which are trans-
ferred to the connecting members). The member itself shows a linear distribution of internal
forces. An exception is the concentrated load on the member, which means that no moment
diagram will be visible as a result of self-weight or a line load. The boundary moments are zero
because of the release. A linear distribution is assumed along the member. The nodal forces,
however, are calculated from the member loads, which guarantees a correct transmission.

The reason for special treatment is that a truss girder, as it is commonly understood, transfers
only axial forces. Moments are not of interest. Therefore, they are deliberately neither shown in
the output nor calculated as a part of the design. To get and see moments from the member
loads, use the member type Truss.

Tension member / Compression member

A tension member can absorb only tension forces and a compression member only compres-
sion forces. The calculation of a framework structure with these types of members is carried
out iteratively. In the first iteration, RSTAB determines the internal forces of all members. If ten-
sion members have negative axial forces (compression), or if compression members have posi-
tive axial forces (tension), an additional iteration step is started in which the rigidity of these
members won't be considered anymore - they have failed. This iteration process continues as
long as tension or compression members are failing. Depending on modeling and loading, the
system may become unstable due to failure of tension or compression members.

A failed tension or compression member can be considered again in the stiffness matrix if it is
reactivated in a later iteration step due to redistributions in the system. You can control the
Reactivation of Failing Members in the dialog tab Global Calculation Parameters of the
Calculation Parameters dialog box that you open by selecting Calculation Parameters on
the Calculate menu. Details can be found in chapter 7.2, page 176.
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Buckling member

A buckling member absorbs unlimited quantities of tensile forces. Compressive forces, howev-
er, can be absorbed only until the critical Euler load is reached.

n? E-l

Ncr =
%

where | =1

Equation 4.5

With this type of member you can often avoid instabilities occurring in calculations according
to second order or large deformation analysis due to buckling of truss members. If you replace
trusses — close to reality — by buckling members, the critical load is increased in many cases.

Cable

Cable members absorb only tension forces. They are used to analyze cable chains with longi-
tudinal and transversal forces by iterative calculations taking into account the cable theory
(large deformation analysis - see chapter 7.2.1, page 170). It is required to define the complete
cable as cable chain consisting of several cable members.

To create catenaries quickly, point to Generate Model on the Tools menu and select Arc
(chapter 11.7.2, page 351). The more accurately the starting shape of the catenary corresponds
to the real cable chain, the more stable and faster you can perform the calculation.

It is recommended to prestress cable members in order to prevent compression forces result-
ing in failure. Furthermore, cables should be used only if deformations have a considerable
part in changes of the internal forces, that means when large deformations occur. For simple
straight riggings like transverse bracings (projecting roof), tension members are completely
sufficient.

When evaluating deformations of cable members, set the scaling factor in the control panel
(see Figure 3.20, page 29) to “1” so that tightening effects are represented realistically.
Stiffnesses

The member stiffnesses can be directly specified in a dialog box that you open with the [Edit]
button. Thus, the assignment of a cross-section is unnecessary.

Dlubal —
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Edit Member Stiffness e e
Torsional and Flexural Stiffness
Torsional stiffress GJ: 5000.000 | [kWm?]
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Figure 4.67: Dialog box Edit Member Stiffness

To look at the definition of the stiffness matrix, use the [Info] button.
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Coupling

A coupling member is a virtual, very stiff member with definable rigid or hinged properties. It
is possible to couple the degrees of freedom of the start and end nodes in four different ways.
The axial and shear forces, respectively torsional and bending moments, are transferred direct-
ly from one node to the other. Couplings can be used to model special situations for the trans-
fer of forces and moments.

RSTAB calculates stiffnesses of couplings depending on the model in order to exclude numeri-
cal problems.

With the alternative Rigid member (see page 75) you can define coupling members consider-
ing also springs and nonlinearities of releases.

To control the display of coupling results, use the Display navigator.

Project Navigator - Display x
- [¥] 5 Model i
w-[J4 Loads
- ¥I[F Results

+E|@ Result Values

..... [ Title Info

..... [ Max/Min Info

+-[B] [ Deformation

5 [J[FE Members

..... O Two-Colored

..... @ [ with Diagram

..... O[S Without Diagram

----- O[S Cross-Sections

----- [ Result Diagrams Filled

..... [#][F Hatching

..... I Al values

----- [1[F Display Hidden Result Diagram

----- [JJFS Reverse Results V-y and V-z

----- E2] | Results on Couplings |

+-[H] [ Support Reactions

.1 Transparent 2

ﬁData EDisplay Aviews T Results

m

Figure 4.68: Activating the display for results of coupling members in the Display navigator

Null (dummy member)

Neither a dummy nor its loads will be considered for the calculation. Use dummies to analyze,
for example, changes in structural behavior if certain members are not effective. You do not
need to delete these members, loading will be kept as well.
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Spring (in preparation)
If Spring non-linearities are set, you can open a new dialog box by using the [Edit] dialog but-
ton or the [...] button in the table.

Edit Parameters for Member of Type 'Spring’ &J

General

Definition Type

+M
@ Parameters

_) Diagram

Spring Constant
Aozl Stiffness
C11: 75.0002]}] fcMim]

Slippage

Use

Hu: 0.030(/ m]
-t 0.000(5>] m]

Limits.
Use
Type

_) Deformation
@) Force

Nin ¢ 0.0005>] n)
Nmax:|  10.000[2]] KNI

@] = 3= ok | [ concal |

Figure 4.69: Dialog box Edit Parameters for Member of Type 'Spring’

Define the spring properties by Parameters or in a Diagram. The spring constant C;,; describes
the stiffness of the member in its local x-direction according to the following relation:

Equation 4.6

The Slippage specifies a zone of the deformation where the spring does not absorb any forces.

Furthermore, you have two options to define the spring Limits:
e Deformation: The values umin and umax define the geometric activity zone of the spring. The
spring will act as a rigid member (stop) for deformations beyond the specified zone.

e force: The values Nmin and Nrmax define the activity zone for the forces that can be absorbed
by the spring. If the axial force is beyond the defined limits, the spring fails.

When the Diagram option is set, you can define spring properties even more precisely. The set-
tings are largely identical with the options available for nonlinear member releases (see chap-
ter 4.4, page 68).
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Node no. start / end

Every member is geometrically defined by a start and an end node. With this definition the
member orientation is defined, which affects also the member coordinate system. The nodes
can be entered manually, graphically selected or redefined (see chapter 4.1, page 41).

The display of member orientations can be activated in the Display navigator.

Project Mavigator - Display x

_Eg Model -

: 3
+E|¥ Medal Supports - 132 2
=[] 5 Members . \ T0r =

-[¥]i Member Elastic Foundations /‘/ P

- ' W
o-[18¢ Member Axis Systems xy,z | g » 130 / 27
\ 108

L

+|:|¥ Member Axis Systemns u,v,w

..... 1% 1cmberOnertations ,
----- [#]5% Member End Releases \ / A
----- 1% Material Descriptions

..... [k Bottom Fibers \ /
----- 1% Cross-Section Outlines 12

----- [ Cross-Section Descriptions 4
----- & Line Mode at Member Ends A 122;21 k

..... E& Eccentricities Ve \ A
----- 1% Front Areas Distinguished by Color ,’/ A

..... [#]% Spring Members /S \
+-[]8¢ Sets of Members - 4 A

ﬁData EDisplay A views

>

Figure 4.70: Activating Member Orientations in the Display navigator

The member orientation can be changed quickly in the graphic: Right-click the member and
select Reverse Member Orientation in the context menu. The numbers of the start and end node
will be interchanged.

Member rotation

The member-related coordinate system x,y,z is defined clockwise by right angles. The local axis
X represents always the centroidal axis of the member, connecting the start node with the end
node of the member (positive direction). Member axes y and z, respectively u and v for unsym-
metrical cross-sections, represent the principal axes of the member.

End

*P I
Help node
in plane x-y

Here
Yz B=0=

Figure 4.71: Member rotation and local member axes x,y,z (any spatial position)

The position of the local axes y and z is set automatically. Axis y runs perpendicular to the lon-
gitudinal axis x and, as far as possible, parallel to the global plane XY. The position of axis z is
determined by the right-hand rule. The z' component of the z-axis always shows downwards
(which means in direction of the gravity) - irrespective of whether or not the global axis Z is
oriented downward or upward.
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To check the member position, use the 3D rendering. You can also use the Display navigator or
the member context menu to display the Member Axis Systems x,y,z.

Project Mavigator - Display x

-5 Model -

[-[¥]5 Nodal Supports
E-[¥]5 Members :
E‘& Member Elastic Foundations -
BT e sy ]
[#]5 Indexes z
-8 Member Axis Systems u,v,w
----- [ Member Orientations

----- [#]5% Member End Releases

----- 1% Material Descriptions o
..... 1% Bottom Fibers
----- 1% Cross-Section Outlines =
----- [ Cross-Section Descriptions -~ z
----- & Line Mode at Member Ends z

..... [#]5 Eccentricities
----- 1% Front Areas Distinguished by ~ -
] i »

ﬁData €Display Aviews T Results

m

Figure 4.72: Selecting the local member axis systems in the Display navigator

Table column O informs you about the global axis running parallel to the member or indicates
the plane spanned by the global axes where the member is lying. If there is no entry, the mem-
ber is in an arbitrary spatial position.

If a member is aligned parallel to the global axis Z, which means in vertical position, the local
axis z, of course, has no Z-component. In this case, the following rule applies: The local axis y
will be aligned parallel to the global axis Y. Then, the position of the z-axis is determined by
the right-hand rule.

=

z

Figure 4.73: Vertical member position for members with different member orientations ( = 0°)

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can
change their orientation. RSTAB classifies the position of a member that is slightly inclined as
"general". If you want to classify members in general position still as vertical, select Regenerate
Model on the Tools menu (see chapter 7.1.3, page 167).

Member rotations can be applied in two ways:

Member rotation via angle

You define an Angle 3 about which the member is rotated. If the rotation angle  is positive,
axes y and z are rotated clockwise around the longitudinal member axis x.

Please note that the member rotation angle 3 and the cross-section rotation angle o' (see
chapter 4.3, page 56) are summed up.

In 2D models, only member rotation angles of 0° and 180° are allowed.
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Member rotation via help node

The member axis system is directed to a particular node. First, select the axis (y or z) that you
want to be affected by the help node. Accordingly, the help node determines the plane x-y or
x-z of the member. Then, enter the help node. It is also possible to select it graphically or to
create a new one. However, make sure that the node does not lie on the straight line that is de-
fined by the x-axis of the member.

The following example shows columns that are aligned towards the center point.

Member Rotation via . i
() Angle B:
@ Help node Mo 15 - ‘_\;
In plane: @y
ez

Figure 4.74: Member rotation via help node

Changes of the local member axis system may affect the signs of internal forces. The following
figure illustrates the general sign rule.

positive area of cross-section

Figure 4.75: Positive definition of internal forces

The bending moment My is positive if tensile stresses occur on the positive member side (in di-
rection of the z-axis). M. is positive if compressive stresses occur on the positive member side
(in direction of the y-axis). The sign definition for torsional moments, axial forces and shear
forces conforms to the usual conventions. These internal forces are positive if they act in a pos-
itive direction.
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Cross-section no. start / end

The two input fields or table columns are used to define the cross-sections for the member
start and end. The numbers of the cross-sections refer to the entries in table 1.3 Cross-Sections
(see chapter 4.3, page 53). Assignment is made easier by colors related to different cross-
sections.

g When you enter different numbers for the start and end cross-sections, a taper is created.
RSTAB interpolates the variable stiffnesses along the member according to polynomials of
higher grade. Input of nonsense like a taper consisting of an IPE cross-section and a round
steel will be identified by the plausibility check before the calculation starts.

Tapered member

The internal determination of tapered cross-section values is controlled by the Taper Shape set
in the Options tab of the New Member dialog box, respectively the table column (see 82).

Member release no. start / end

In these two table columns or input fields of the New Member dialog box, you can define re-
leases controlling the transfer of internal forces on nodes. The release numbers refer to the en-
tries in table 1.4 Member End Releases (see chapter 4.4, page 64).

For some of the member types, entries are not possible because internal releases already exist.

Member eccentricity

In this table column or input field of the Options dialog tab (see Figure 4.66), you can assign an
eccentric connection to the member. The numbers of the eccentricities refer to table 1.5 Mem-
ber Eccentricities (see chapter 4.5, page 70). A connection type determines the eccentricities of
both the member start and the member end.

Member division

Member divisions control the numerical output of internal forces and deformations along the
member (see chapter 4.6, page 72). Use the settings in the table column or the input field of
the Options dialog tab to assign divisions or to create new ones. The numbers of the divisions
refer to the entries in table 1.6 Member Divisions.

A member division has neither influence on the determination of extreme values nor on the
graphical results diagram (RSTAB internally uses a more refined partition). As member divi-
sions are not required in most cases, the default setting is 'None' or '0'".

Taper shape

If different cross-sections are defined for the member start and member end, this table column
or input field in the Options tab offers you the choice between Linear and Quadratic taper lay-
out. In this way, it is possible to describe the taper geometry for the determination of the in-
terpolated cross-section values.

In most cases, a linear taper course is existent: The height of the cross-section is changing
evenly from the start to the end cross-section, the width remains more or less constant. How-
ever, if also the width of the cross-section is changing distinctly along the member (for exam-
ple taper made of solid sections), it is recommended to use a square function for the interpola-
tion of cross-section values.

Length
This table column indicates the absolute length of the member as distance between start and
end node. Eccentricities are taken into account.

You can read the member length also in the work window: Place the mouse pointer on a mem-
ber and wait a moment until the ScreenTip of the member appears.
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Weight

The mass of a member is determined from the product of the cross-sectional area A and the
specific weight of the material. RSTAB applies g = 10 m/s? for gravitational acceleration.

Position

Table column O informs you about the global axis running parallel to the member, or it indi-
cates the plane spanned by the global axes where the member is lying. If there is no entry, the
member is in an arbitrary spatial position.

When a member located in a continuous set of column members is not exactly in vertical posi-
tion (because of minor deviations of the nodal coordinates X or Y), the axes of the member can
change their orientation. RSTAB classifies the position of a member that is slightly inclined as
"general”. If you want to classify members in general position still as vertical, select Regenerate
Model on the Tools menu (see chapter 7.1.3, page 167).

Member elastic foundation

With this input field of the Options tab (see Figure 4.66) you can assign an elastic foundation to
the member. The numbers of the elastic foundations are managed in table 1.9 Member Elastic
Foundations (see chapter 4.9, page 91).

Member nonlinearity

This input field in the Options dialog tab makes it possible to provide the member with nonlin-
ear properties (see Figure 4.66, page 74). The numbers of the non-linearities refer to the entries
in table 1.10 Member Nonlinearities (see chapter 4.10, page 93).

Effective lengths

The dialog tab Effective Lengths manages the Effective Length Factors key and Kez.

Edit Member [

Effective Lengths | Modify Stiffnesses

Member No.
1

Effective Length Factors Effective Lengths IPE 400
kery : 1000 ~ A Lery: 3.000 5| m] =
kerz: 1500 =+ [ Lerz: 4500052 [m]
_________ -
(o= ]
]
r
Member Length Critical Buckling Load
L: 3.000 [m] Mer: 1345.508 [kN]

Check exceeding of critical buckling load on
calculation

2] &) (@) (&) oK | [ Cancel

L 4

Figure 4.76: Dialog box Edit Member, tab Effective Lengths

The effective length factors can be adjusted separately for both member axes. The dialog fields
to the right show the Effective Lengths resulting from the entered factors and the member
length.
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Effective length factors are significant for add-on modules like STEEL EC3 where stability anal-
yses are performed, but they play a secondary role for RSTAB as for example buckling lengths

for buckling members are determined internally from the boundary conditions, and then they
are applied exactly.

In the dialog section Critical Buckling Load, you can decide if the flexural buckling load of the
member will be checked during the calculation. The check box is ticked by default for truss,
compression and buckling members. The dialog tab Global Calculation Parameters of the Cal-
culation Parameters dialog box (see Figure 7.14, page 176) offers a global setting option for this
kind of control.

Modify stiffness
The dialog tab Modify Stiffness allows you to have an influence on the member stiffnesses.
Edit Member [
| General I Options I Effective Lengths | Modify Stiffness |
Member No.
2
Modify Stiffness via Factor IPE 300
Multiplier factor ===
Torsion stiffness Gl: 0.30 (x| H
Flexural stiffness Ely : 10~ (| T it
Elz: 100 5 [
e
'
Fodal stiffness EA: 100 « 5 H -
Shear stiffress Ghy : 050 =&k M
GAz: 050 « 5| H
D E® e

L5 A

Figure 4.77: Dialog box Edit Member, tab Modify Stiffness

RSTAB presets a Multiplier factor of 1.00 for the torsional, flexural, axial and shear stiffness of
the member: All stiffness components are taken into account by the calculation as they stand.
If required, it is possible to define a reduction or increase factor in the input fields so that you
can adapt the member stiffnesses.

In case changes have also been made for the cross-section stiffnesses (see chapter 4.3, page
55), they are additionally taken into account by the calculation.

Double members

Generally, overlapping members in the model are not desired. So when you define a new
member on the nodes of an already existing member, RSTAB will delete the old member
automatically.

To prevent RSTAB from deleting already defined members, select Allow Double Members on
the Edit menu. RSTAB will consider the stiffnesses of both members in the calculation.
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4.8 Nodal Supports

General description

Supports are used to transfer loads applied on a structural system into the foundations. With-
out any supports all nodes would be free and could be displaced or rotated. If you want a node
to act as a support, at least one of its degrees of freedom must be blocked or restricted by a
spring. In addition, the node must be part of a member. The boundary conditions of a member
must be considered as well to exclude a double release on the supported node.

Nodal supports are required in order to apply imposed deformations.

Itis possible to provide nodal supports with nonlinear properties (failure criteria for tensile or
compressive forces, working and stiffness diagrams).

I ~
MNew Modal Support @
Support No. On Nodes No. o
24
1 B T‘
Support Rotation z
Sequence; Fiotated about

f o
:

"

Elastic Support via
[ Column in Z...

Support Conditions

Suppart Spring constant Manlinearity

uz CuZ: I:I [Failure all if negative P=" v] =

Restraint

O ex Couir: [kMm/rad] [None v] )
Do Cou¥: 0.0002]3]| (khmérad] (None =
9T Coz: = [None v] =]
(&) &) (&) [«)

Comment

= Ok ][ Cancel

L 4

Figure 4.78: Dialog box New Nodal Support

1.8 Nodal Supports x
BEESE SN0 @3 X K | FE e Em F LA
[ A T B8 [ ¢ T [ ETFT G [mewces 1 [ J T K T T -
Support Support Rotation [7] Support or Spring [lk/m] Rotational Restraint or Spring [kNm./rad]

No. | On Nodes No. Sequence| about X |about Y |about Z| ux uy uz X a4y (7 Comment
1222 XrZ 000[ 000[ 000 [m] [m] E
46 XrZ 000 o0o00[ o000l O | O [ 11320000 [m] [m]

(R 4 Xz 000 000 o000 ] ]

4 Yes k

5 No

[ Spring constant

7 Failure if negative PZ'

2 Failure if positive PZ'

5 Failure all f negative PZ' -
Nodes | Materials | Cross-Sections | Member End Releases | Member Eccentricities | Eaalil_;l::iiﬁv;:smve Pz aNodal Supports FH
Support condition for translational movement ('V'es / 'N'o / Spring Constant pizgzm. ot)

Friction P3X...
Friction PY"...
Friction P PY"...

Friction PX+PY"...
Figure 4.79: Table 1.8 Nodal Supports
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| i | To open the following dialog box, open the Insert menu, point to Model Data and Nodal
Supports, and then select Graphically, or use the toolbar button shown on the left:
f New Nodal Support @1
Type of Support
| AE@ | OO E | Hinged =
OO&  Hinged - #
Rigid
OFE OO  Shdng ins

FMOFE OO  Slidinginy'

[ 0K ][ Cancel ]

%

Figure 4.80: Dialog box New Nodal Support

The following support types are predefined and can be selected from the list:
e Hinged (YYY NNY)
e Rigid (YYY YYY)
o Slidingin X' (NYY NNY)
e Slidingin Y (YNY NNY)

After clicking the [OK] button you can assign the selected support type to nodes in the graphic.

Use the [New] button to create another type of support. The dialog box shown in Figure 4.78
appears.
On nodes
;1 Singular supports can be defined only on nodes. Enter the node number into the table column

or the input field of the dialog box. You can select it also graphically.

Support rotation

Each nodal support has a local coordinate system which is oriented parallel to the global axes

& Edit Nodal Support...
& Delete Nodal support X, Y and Z by default. Use the context menu of the nodal support to activate the display for the
support coordinate systems.
ﬁ Increase Size
| Decrease Size Itis possible to rotate the support's local axis system. First, select the Sequence that determines
— — the order of the local support axes X', Y' and Z'. Then, enter the angle of rotation for the global
XIS SYSTEmS Oony/o . . . H
! % axes X, Y and Z into the input fields below Rotated about. You can use the dialog buttons [»]
A | Display Properties... to define the support rotation also graphically (see Figure 4.81).

Context menu of nodal support
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MNew Modal Support &J
Support No. On Nodes No.
> l ey
=
2 a
Support Rotation z
Sequence; Fiotated about
®Z - % [ asooR] [ -
vo [ 00 /\
Z 0.00041 |l &2 | calculator iy

fx Edit Formulas
Elastic Support via l 8 Full Precision
[C] CalumninZ... = ¥ | Set Angle via Pick of 2 Points 5 (2] () (a
BT TS (3 Set Angle via Pick of 3 Points
Sl St el 2,7 Pick Member and Import its Rotation
i Cux : = [None v] =
e Cuv =l lNone v] =
uz Cuz: =l lNone v] =
Restraint
[ ox Coux: 0.000[2 2] [kNmérad] [None BIE
Oev Cout: 0.00012]>]| [kNmérad] [None BIE
['¥s CoT: =l lNone v] =
(=) () (&) (2] (&) (o] (X]
Comment

- [&]

=4 0K ] I Cancel

Figure 4.81: Dialog box New Nodal Support with options for support rotation

The entered support rotation is shown in the interactive dialog graphic.

When the calculation is complete, you can evaluate the support reactions of a rotated nodal
support in relation to the global as well as the local axis system.

Support or spring

To define a support, select the corresponding option in the dialog box or table. The check
mark indicates that the corresponding degree of freedom is blocked and the node displace-
ment in the corresponding direction is not possible.

If you don't want to define supports, clear the corresponding check box. Then, RSTAB sets the
constant of the translational spring to zero in the Nodal Support dialog box. It is always possi-
ble to modify the spring constant in order to represent an elastic support of the node. In the
table, enter the constant directly into the table column.

The spring stiffnesses must be entered as design values.

Assigning nonlinear support properties is described below.

Restraint or spring

Restraints are defined in a similar way as supports. Again, the check mark indicates that the
corresponding degree of freedom is blocked and the node displacement in the corresponding
direction is not possible. The constants for rotational springs can be defined as soon as the
check boxes are cleared. In the table, enter the spring constant directly into the corresponding
table column.
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The dialog box New Nodal Support (see Figure 4.78, page 85) provides buttons for different
support types, making the definition of degrees of freedom easier.

(=] (4] (&) (&) (2] [« [X]
Figure 4.82: Buttons in the dialog box New Nodal Support

The buttons are reserved for the following support properties:

Button Support type

Rigid

Hinged with restraint about Z'

Sliding in X' and Y' with restraint about Z'

Sliding in X' with restraint about Z'

Sliding in Y' with restraint about Z'

Sliding in Z' and Y' with restraint about Z'

(3] | (]| o] | () | ] | ] | 2]

Free

Table 4.2: Buttons in Nodal Support dialog box

Non-linearities

To control in detail the transfer of internal forces, it is possible to provide nodal supports with
nonlinear properties. The list of non-linearities includes the following options:

¢ Failure of component if support force or moment is negative or positive
e Complete failure of support if support force or moment is negative or positive
e Partial activity
e Diagram
e Friction depending on remaining support forces
The non-linear properties can be accessed in the dialog box and table by using the list (see

Figure 4.78 and Figure 4.79). In this way, you can define for each support's degree of freedom
whether and which forces or moments are transferred at the supported node.

Nonlinear effective supports are displayed with a different color in the graphic. In the table,
support elements having non-linear properties are indicated by a blue check box.

Failure if support force/moment is negative or positive

Both options control easily for each support component whether only positive or negative
forces/moments are transferred on the supported node. If this condition is not fulfilled, the
relevant component of the support fails. The remaining retentions and restraints are still effec-
tive.

Positive or negative refers to the forces or moments that are introduced to the nodal support
with regard to the respective axes (they do not refer to the reaction forces of the support). So
signs are resulting from the direction of the global axes. If the global Z-axis is oriented down-
wards, the load case 'Self-weight' results in a positive support force Pz.

Failure all if support force/moment is negative or positive

In contrast to the failure of a single component described above, the support fails completely
as soon as the component is ineffective.
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To access the following dialog boxes, use the buttons [Edit Nonlinearity] or [¥] to the right of
the list available in the dialog box and table.

Partial activity

Nenlinearity - Partial Activity - Nodal Suppaort u-Z' &J

Support Activity in Positive Zone Activity Diagram

‘@ Complete +Pz
Fixed from support displacement u+
Tearing from support force P+
“ielding from support force P+

Failure

Slippage Us+: 0.00012]] [m] z

Support Activity in Negative Zone
Complete
Fixed from support displacement u-

@ Tearing from support force P-

“ielding from support force P- Pz
Failure
Support force P- 1500015 #| [kM]
Slippage Us- © .00 x| [m]
j ﬁ ak. ] | Cancel

L S

Figure 4.83: Dialog box Nonlinearity - Partial Activity

The support's effect can be defined separately for the Positive and Negative Zone. The sign rule
is described in the previous paragraph. In addition to Complete activity or complete Failure, the
support can be set to be effective only when it is displaced or rotated to a certain degree. In
this case, a translational or rotational spring should be defined before.

Furthermore, Tearing (failure of support when exceeding a certain force or moment) as well as
Yielding (effective only until force or moment is reached) can be set in combination with a Slip-

page.
Look at the dynamic dialog graphic called Activity Diagram to check the support properties.
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Diagram

r

Nenlinearity - Diagram - Nodal Support u-X' &J

Positive Zone Diagram
Humber of +ux [m] Px [kN]

= Py
steps: 25 1 0.000 0.000
[ 2 ] 115.000

Diiagram after last
step:

_) Tearing

) Yielding

) Continuous
@ Stop

Negative Zone
[T Symmetric. about the ux [m] Px [kN]
origin 1 0.000 0.000

Humber of [ 2 ] -0.020 -55.000 =
steps: 3 3 -0.050 -75.000

i +UY

Diiagram after last
step:
_) Tearing
@ “Yielding
) Continuous
) Stop
Px

@@@@ @@@J 0k ]l Cancel

Figure 4.84: Dialog box Nonlinearity - Diagram

The support's effect can be defined separately for the Positive and Negative Zone. First, define
the Number of steps (that means definition points) for the working diagram. Then, enter abscis-

sa values of the displacements or rotations with corresponding support forces or moments in-
to the list to the right.

You find different options for the Diagram after last step: Tearing for support failure when ex-
ceeding, Yielding for restricting the transfer to a maximum allowable support force or moment,
Continuous as in the last step, or Stop for restricting to a maximum allowable displacement or
rotation followed by a rigid or restrained support activity.

Friction depending on support force

Use the four friction options to set the transferred support forces in relation to the compres-
sive forces acting in another direction. Depending on your selection, the friction depends on
only one support force or on the total force of two support forces acting simultaneously.

Click the [Edit] dialog button to open a dialog box where you can define the Friction Coefficient
[V

Friction Coefficients

s 00| [

Figure 4.85: Dialog box Friction in uX' (dialog section)
The following relation exists between axial force and friction force of the support:

PSupport =1 Paial force

Equation 4.7

20
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49 Member Elastic Foundations

General description

While nodal supports represent a support on both member ends, member elastic foundations
provide an elastic support of the member along its entire length. Use elastic member founda-
tions to model for example foundation beams considering soil properties. If the elastic founda-
tion is not effective in case of tensile or compressive stresses, it is possible to take into account
nonlinear effects in the calculation.

I ~
New Member Elastic Foundation @
No. On Members No.
1 2

Spring Constants

Tranglational spring constant Shear =pring constant

Cr 0.0005 | [MN/m?] Ca 0.00015 | [MN]
Ciy: 0.0005 | [MN/m?] Caye 0.00015 | [MN]
Ciz: | 75000.0005 x| [MMN/m] Cza: 0.00015 | [MN]

Fiotational spring constant
Co: 00005 x| [MMm/radim]

Foundation Ineffective

[None v]

Comment

-
Ok ] [ Cancel

L A

Figure 4.86: Dialog box New Member Elastic Foundation

1.9 Member Elastic Foundations x
| = | [I€ O | [ [5][5]| ]| &&= | FHE= EEa F A
A [ B [ ¢ [ Db [ E [ F [ & [ H -
Found. Cix Ciy C1z Czx Czy Ca2z Ce Foundation
No.  |On Members No. | [kN/m2] | kN/m2] | [kN/m2] kNI [kN] [kN] [kNm/rad./m] Ineffectiveness Commert
5 0.000 |  0.000 [ 75000.000 0.000 0.000 0.000 0.000 1
2 i3 0.000|  0.000 | 50000.000 0.000[  0.000 0.000 0.000 i
3 MNone
1
5 If contact stress is positive e
Member Eccentricities | Member Divisions | Members | Nodal Supports | Member Elastic Foundations | Member Nonlinearities | Sets of Members | 14/ 4] » |

Ineffective foundation ('N'one / Under ‘T'ension / Under 'C'ompression / F7 to select)

Figure 4.87: Table 1.9 Member Elastic Foundations

On members

Member elastic foundations can only be defined for the member type Beam. Enter the number
of the member into the table column or input field. You can also define it graphically.
Spring constants

Translational spring
You have to specify the parameters of translational springs in direction of the local member
axesx, yand z.

The stiffness moduli Es of Table 4.3 serve as reference values. Please note that input in RSTAB
refers to the foundation module to be determined by taking into account the form factor.
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Soil type Es (static loading) Es (dynamic loading)
Sand, compact 40-100 200 - 500
Gravel sand, compact 80-150 300 - 800
Clay, semi-solid to solid 8-30 120 - 250
Clay, stiff-plastic 5-20 70-150
Mixed soil, semi-solid to solid 20-100 200 - 600

Table 4.3: Stiffness moduli of selected soil types in [N/mm?]

The values of Table 4.3 represent area-related characteristic values: They describe the area
force in [N/mm?] that is required to compress the soil by T mm. Thus, the unit would be inter-
preted in a solid-related way as [N/mm?].

For foundation beams used for example to model strip foundations, you have to determine
the spring coefficient taking into account the cross-section width. In this way, you get a trans-
lational spring in [N/mm?] that is related to the member. The spring indicates the member
force in [N/mm] that is required to compress the soil by T mm - therefore the unit [N/mm?] for
the input. The result must be entered as translational spring C;..: For strip foundations (mem-
bers in horizontal position) the local z-axis is usually directed downwards.

The spring stiffnesses are considered as design values.

Use the Display navigator or the context menu of the member to display the local member
axes (see Figure 4.72, page 80).

Shear spring

Shear springs are used to determine the shear capacity of the soil. The spring constants C; are
determined from the product of v - Ci., with the Poisson'’s ratio v to be assumed between
0.125 and 0.5 for sand and gravely soil, and between 0.2 and 0.4 for clayey soil.

Rotational spring

Enter the constant of a rotational spring into the dialog input field or table column. The con-
stant hinders the member rotating about its longitudinal axis.

Ineffective foundation

If the elastic foundation is not effective in case of tensile or compressive stresses, assign the
nonlinear property Failure to the foundation type.

Please note that the failure criterion Failure if negative or positive contact stress in z only refers
to the local member axis z. The nonlinearity does not apply to the translational springs in di-
rection of the local axes x or y! Thus, a biaxially effective failure of foundation members is not
possible.

An ineffectivity in case of a negative contact stress has the following meaning: The foundation
is without effect if a member element moves in opposite direction of the local axis z.

When failure criteria is applied, it is recommended to check position and orientation of the lo-
cal z-axes (see Figure 4.72, page 80). It might be necessary to rotate members.

The member division of members with elastic foundations can be adjusted in the dialog tab
Global Calculation Parameters of the dialog box Calculation Parameters (see chapter 7.2, page
176).
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410 Member Nonlinearities

General description

Member non-linearities are used to represent non-linear relations between force (or moment)
and strain in members.

Some non-linear properties can be set already when defining the member type. A tension
member, for example, is a truss for which the strain is increasing proportional to the tension
force, but whose strain may rise under compression without needing a verifiable force for it.

In principle, member non-linearities can be assigned to any type of member. Of course, com-
binations have to make sense. A compression member with the design criterion "Failure under
compression” would cause problems during the calculation. Therefore, member nonlinearities
are not allowed for the member types tension, compression, buckling and cable member as
well as for members with cross-sections of the type Dummy Rigid (see page 54).

MNew Member Nonlinearity @

No. On Members No.

1 8 DY

Parameters Tension
Type:
‘ielding -

Failure under tension

Failure under compression

Failure under tension with slippage
Failure under compression with slippage
Slippage

Tearing under tension

“Yielding under tenzion Compression
Tearing under compression

“ielding under compreszion

T earin

N —
Flastic hinge -
0k ] [ Cancel

L5 A

v

— N,

uy

—.l Migm fe—

Figure 4.88: Dialog box New Member Nonlinearity

1.10 Member Nonlinearities x
EEE EEIEO | E[@E | E K| FHE EwES AR
c [ o [ E T F T G T H ] I [ -
Monlin. Type of Monlinear Parameters

No. | On Members No. Nonlinearity Nt [kN] | Wyt [eN] | Vz,pi [N] | MT gt lkNm] | My gt [kNm] | Mz,pi [kNm] | Comment

1 10 Yielding 300.00 300.00

2 5 Failure under tension L

3 23 Failure under tension with slippage r
4 Plastic hinge -] 9999.00| 9995.00| 9999.00| 9995.00  150.00| 9959.00

5

& | 4

7 o
Member Eccentricities | Member Divisions | Members | Nodal Supports | Member Elastic Foundations | Member Nonlinsarities | Sets of Members | 14/ 4] |

Type of nonlinearity (F7 to select)

Figure 4.89: Table 1.10 Member Nonlinearities
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+N
Tension

— /

|

L

Uy
/ Uy 4—

on

Compressi

Nonlinearity Diagram Description
Failure under - The member cannot absorb tensile forces.
H 2 Tension
tension
| .
L4
u
Compression
Failure under ‘N A The member cannot absorb compressive forces.
compression 1+ ensen
|
>
+ U
Compression
Failure under ten- ‘N A The member cannot absorb tensile forces.
. . . Tension
sion with slippage Compressive forces are not absorbed until the
— Uy — . .
slippage ux is overcome.
| .
/ r
Uy
Compression
ailure under _ iv .
Fail d N The member cannot absorb compressive forces
H : Tension
compression with Tensile forces are not absorbed until the slip-
slippage / page ux is overcome.
|
>
u
Uy —
Compression
Slippage The member absorbs axial forces only after

having exceeded a strain or shortening by the

value ux.

Tearing under
tension

Tension

bl

+ Uy

nA

N+

Compression

The member absorbs compressive forces with-
out limitation but fails if tensile forces exceed

Nto.
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Yielding under
tension

Tension

The member absorbs compressive forces with-
out limitation, but only a maximum tensile force
of Nro.

compression

> If the strain increases, the tensile force remains
constant in the member.
Compression
Tearing under N . The member absorbs tensile forces without limi-
ension

Compression

tation but fails if compressive forces exceed
Nfrom.

Yielding under

The member absorbs tensile forces without limi-

Tension
compression tation, but only a maximum compressive force
of Niom.
- . .
e If the strain increases, the compressive force
i remains constant in the member.
Compression
Tearing N The member fails when reaching the compres-
Tension . .
sive force Nrom Or the tensile force Ni.
Compression
Yielding N The member starts to yield if the compressive
Tensi .
s force Nrom Or the tensile force Ni are reached: If
’9— the strain increases, the force remains constant.
= ¢ |
) B tu
z
f
Compression
Plastic hinge If a plastic design force is reached on a location
M N . .
o Nol_ypre of the member, a plastic hinge is formed there
" .
= for the internal force.
.-—“‘ ., “'b._,’ir-P' .
+= The internal forces must be entered as absolute
Ve values. For components of internal forces not
Mept resulting in plastifications, you have to enter

high values.

Table 4.4: Member nonlinearities
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411 Sets of Members

General description

load application).

”;I_‘_‘: 1 1 __j :__ L

Engineering Software

Sets of members must be understood as combined members. Use a set of members to treat
several members like a single member as it may be preferable for some locations in the struc-
tural system (for example for lateral-torsional buckling analysis, design of continuous beams,

Figure 4.90: Continuous members with trapezoidal load

members.

The figure above shows a linearly variable load acting on the complete length of a set of

-

New Set of Members

S5

No. Description

1 Frame beam -

Type
(